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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©December 2009
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FCC Statement

(Federal Communications Commission)

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1.

This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This

equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

\ A/
ZAS
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product




Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

@

Do not leave it in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Perform routine maintenance
on your computer.

Do not disassemble the com-
puter by yourself.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

» Only use a power adapter approved for use with this computer.

» Your AC/DC adapter may be designed for international travel but it still requires a 7Il,<
steady, uninterrupted power supply. If you are unsure of your local power specifications, Power Safety
consult your service representative or local power company. Warning

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third Before you undertake
prong is an important safety feature; do not defeat its purpose. If you do not have access any upgrade proce-

to a compatible outlet, have a qualified electrician install one. dures, make sure that
you have turned off the

power, and discon-

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by its wire.

. nected all peripherals
» Make sure the socket and any extension cord(s) you use can support the total current e

and cables (including

load of all the connected devices. telephone lines). It is
» Before cleaning the computer, make sure it is disconnected from any external power advisable to also re-
supplies (i.e. AC/DC adapter or car adapter). move your battery in
order to prevent acci-
dentally turning the
Do not plug in the power Do not use the power cord if | Do not place heavy objects machine on.
cord if you are wet. it is broken. on the power cord.

\1
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Battery Precautions

« Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

« Do not remove any batteries from the computer while it is powered on.

« Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

 If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

\ A/
ALK
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

VI
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

« If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

Xl
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

< Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

¢ Use a chair with a back and adjust it to support your lower back comfortably.

« Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

e Take periodic breaks if you are using the computer for long periods of time.

Remember to:

e Alter your posture frequently.

»  Stretch and exercise your body several times a day.

»  Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system is not in use.

X1l
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.

e Chapter 3  The computer’s power saving options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 6  Instructions for upgrading your computer.

» Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN, 3.75G/HSPA and Secu-
rity modules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

« Appendix B Information on the AT1 Video driver controls.

» Appendix C The computer’s specification.
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a /Z of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark . remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
tors foatire. e <™ | may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows Vista/Windows 7) and applications (e.g. word processing, spreadsheet and da-
tabase programs) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See Appendix A for a description of the interface (ports & jacks) which allow your computer to communicate with external
devices, connect to the internet etc.

. |
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System Startup

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

o

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu
in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In

1 -4 Overview
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System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported (see Appendix D for Windows 7 specific information).

Operating System & Version Note

Windows Vista - SP2 In order to run Windows Vista/Windows 7
without limitations or decreased performance,
your computer requires a minimum 1GB of
system memory (RAM).

Windows 7

Table 1 -1 - Operating Systems Supported

4

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which includes Service Pack 2) before installing
any drivers. Go to the Microsoft website for download details, or contact your service center.

Overview 1 -5
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Model Differences

This notebook series includes two different model types. The models differ as indicated in the table below however
all other features, modules and specifications are identical (see Appendix D).

Feature Model A Model B
Byl Tee 17" WXGA(1440 * 900) / 15.6"HD 16|;9D\J’rv'(‘i‘gosociegeé‘0§1/366 768)/
Supported WUXGA (1920 * 1200) TET LCD

FHD (1920 * 1080) TFT LCD

Design

[l e

O S [ TS T i T8 T 108 O
' A e e M e e e JEJE R 1'[1‘
S el T SO 5, T8
ol | o) | o | 5
= A N e e
(O | O T e

[l

Table 1 - 2 - Model Differences

1 - 6 Model Differences
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System Map: LCD Panel Open - Model A I
igure 1 -

SN LCD Panel Open
’Q\ (Model A Computers)
Wireless Device

Operation Aboard Aircraft 1. Built-ln PC Camera
2. LCD

The use of any portable electronic trans- 3. Power Button
mission devices aboard aircraft is usually
prohibited. Make sure the module(s) are g EOt E)(ey(IjSuttonS
OFF if you are using the computer aboard : e_y oar )
aircraft. 6. Built-In Microphone
Use the key combinations to toggle power 7. Touchpad &
to the 3.75G/HSPA/WLAN/Bluetooth Buttons
modules, and check the LED indicator 8. Fingerprint Module
icon to see if the modules are powered on (Optional)
or not (see 8 9. LED Indicators

).

Seemm—

\ 7
‘_';@— ~ . e Touchpad Buttons
(valid operation area)

System Map: LCD Panel Open - Model A 1-7
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1 System Map: LCD Panel Open - Model B
igure 1 -

LCD Panel Open ;L'X;
(Model B Computers)

Wireless Device

1. Built-In PC Camera Operation Aboard Aircraft
2. LCD
3. Power Button The use of any portable electronic
transmission devices aboard air-
4. Hot Key Buttons craft is usually prohibited. Make
5. Keyboard sure the module(s) are OFF if you
6. Built-In Microphone are using the computer aboard air-
7. Touchpad & craft.
Buttons Use the key combinations to toggle
8. LED Indicators e power to the 3.75G/HSPA/WLAN/
= i Bluetooth modules, and check the
. . | i =) uuuuuummuum LED indicator icon to see if the
Note: The I_:mgerprlnt A : : : : u JE_JIE |[__]1 JEJEL = ] modules are powered on or not
Reader module is also an (see /
option for Model B com- ' L U i ).

puters.

N\ 7
Touchpad Buttons (valid operation area

1 - 8 System Map: LCD Panel Open - Model B
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LED |ndlcat0r3 Icon Color Description
The LEII_) indicators on the computer display helpful Orange DC Power s Plugged In
information about the current status of the computer.
Green The Computer is On
DY) P
Icon Color Description Blinking Green The Compl\l/ljz)e(;els in Sleep
= Green Hard Disk Activity Orange The Battery is Charging
Green The Battery is Fully Charged
&I Green Number Lock Activated m
. The Battery Has Reached
Blinking Orange Critically Low Power Status
Green Caps Lock Activated tcally Low Fow u
. . The (optional) Wireless LAN
- Green Scroll Lock Activated (to activate Green Module is Powered On
press Fn & Scr Lk) (tx))
Orange The (optional) Bluetooth
9 Module is Powered On

Table 1 - 3 - LED Status Indicators
Table 1 -4 - LED Power & Communication Indicators

. |
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4

Other Keyboards

Hot Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program,
and allow you to toggle the Silent Mode on/off with one quick button press.

If your keyboard is
damaged or you just Hot Key Function
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

Activate the Default E-Mail Browser (Note that in Windows 7 this button
will only function after Outlook or Outlook Express are installed)

Activate the Default Internet Program

SISKY

Toggle *Silent Mode (for power saving)

Table 1 -5 - Hot Key Buttons

NumLk & ScrLk *When enabled, Silent Mode will reduce fan noise and save power consumption.

el sl il B [GEy Note this may reduce computer performance.

and either NumLk or

ScrLk to enable num- 4

ber or scroll lock, and ial Ch

check the LED indica- Special Characters

tor for status. Some software applications allow the number-keys to be used with Alt to produce special characters.

These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10 Hot Key Buttons & Keyboard



Keyboard - Model A

Quick Start Guide

The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to
allow you to change operational features instantly. See Table 1 - 6, on page 1 - 13 for full function key combi-

nation details.

Esc F1 F2 F_}_ = F4 F§ FB F}"_ Fa F8 F10

PriSc Pause ! *

Num Lk

=) () @) (@ @& @ (G G G m SysRq  Break O ) MO
IR @ # $  Function Keys & * ( ) _ ]
S E 2 3 4 5 6 7 8 9 0 hiagas ot Numllzk & -
ScrLk Keys
Play/Pause Key . R T Y T | } I Yy
Tab'=,, ] \ y 8 5
Home f PgUp
Caps Lock A S D F G H J K L . | . «— Enter 4 5 6
3.75G/HSPA Module Numerical Keypad
_ Z X C \" B N M = Power
{+Shift {rShif
I ) Toggle Key e 1 2 3
End | PgOn
Cirl Fn - Alt Alt B el F'g‘u: 5 =
< v > —
Fn Key o | @D | ), |

Figure 1 - 4 - Keyboard - Model A

Keyboard - Model A 1-11
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Keyboard - Model B

The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to
allow you to change operational features instantly. See Table 1 - 6, on page 1 - 13 for full function key combi-
nation details.

E F1 F2 _ || [F3 _ Fé F& _ F8. | ['F?.__ F8 __ Fa_ Fi0 _ | [F11_ F12_ PrtSc Pause dns _Del_ / ¥*
* & = &) @ ) a9 Qb 54 ), (L) (D)} 4] @) | | syskq Break Serik)) | Qum Lk

= i . NumLk & =

o ! @ # $ | Function Keys * ( ) y « s SOILK Keys T

~ 1 2 3 4 5 6 7 8 9 0 = Del

PlaylPauseKey (W) (E 1 (R [T 1 [Y 1[0 1T 1o I[P [t 17 [ 7 1@ (e
- [ 1 \ Home T Pglp

Caps Lock A S D F G H J K L : i it 5 5~

3.75G/HSPA Module Numerical Keypad

i Z X C Vv B N M < Power : FRlL 2 3

es s Toggle Key fomt @YW | | na 4 PgDn

ot @ - A Al B 2 H*_ :_'_ﬁfrr':iu'- : _:r ro il

Fn Key

Figure 1 - 5 - Keyboard - Model B

.|
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Fn Keys Function Fn Keys Function

Fn+~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase OQ
At dl

3.75G Module Power -8 p Display Toggle. See “Switching Displays Using Fn + F7”
Fn+_[j _‘ &7 Cﬁ% Fn+F7 onpageB -4

Toggle*

Fn+F1 Touchpad Toggle (BN [ A ) Fn + F8/F9 Brlghtr:ess Decrease/ QQ &,
8 / ncrease amumm | = /

Turn LCD Backlight Off PC Camera Power =
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F10 Toggle & f

Fn+F3 Mute Toggle

(N ﬂ
M‘ L ——
WLAN Module Power ’ = V- e
Fn+F11 Toagle on, (G
99 / /
Fn + F4 Sleep Toggle Fn +F12 BluetoothT(l;/lgc;ctle Power m m
i i
*Sjlent Mode Toggle | o *When enabled, Silent Mode will reduce fan noise and save power
99 Qoo <’ consumption. Note this may reduce computer performance.
4 4

Table 1 - 6 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 13
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s System Map: Front & Left Views
igure 1 -

1. LED Power & Com-

munication Indica-

tors
2. DC-In Jack
3. External Monitor
Port
4. RJ-45 LAN Jack
5. e-SATA Port
6. HDMI-Out Port
7. Vent/Fan Intake/
Outlet 7-in-1 Card Reader
8. 2*USB 2.0 Ports
9. ExpressCard Slot The card reader allows you to use the most popular digital storage card formats:
(see page 2 - 7) MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
10. 7-in-1 Card Reader MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

———

1-14 System Map: Front & Left Views




System Map: Right & Rear Views

CD/DVD Emergency Eject Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up
the control panel to allow you to adjust the regional
code.

If you need to manually eject a CD/
DVD (e.g. due to an unexpected
power interruption) you may push the
end of a straightened paper clip into
the emergency eject hole. Do not use
a sharpened pencil or any object that
may break and become lodged in the
hole. Don't try to remove a floppy DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

disk/CD/DVD while the system is ac-
cessing it. This may cause the sys-
tem to “crash”.

Quick Start Guide

Figure 1 -7
Right & Rear Views

1. S/PDIF-Out Jack

2. Microphone-In
Jack

3. Headphone-Out

Jack

USB 2.0 Port

Optical Device

Drive Bay (for CD/

DVD Device - see

page 2 - 3)

RJ-11 Phone Jack

Security Lock Slot

8. Battery

SNz
ALK

Disk Eject Warning

ok

N o

Don't try to eject a CD/DVD
while the system is accessing
it. This may cause the system
to “crash”. Stop the disk first
then eject it, or press the stop
button twice.

System Map: Right & Rear Views 1 - 15
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=

Figure 1-8
Bottom View
(Model A
Computers)

Battery

RAM & CPU Bay
Cover

Vent/Fan Intake/
Outlet

Hard Disk Bay
Cover
3.75G/HSPA
USIM Card
Location
Speakers

System Map: Bottom View - Model A

4

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Energy Star Power
Saving” on page 3 - 10 for
full instructions.

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

1-16 System Map: Bottom View - Model A
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System Map: Bottom View - Model B

Figure 1-9
Bottom View
d (Model B

Battery Information Computers)
Always completely dis- 1. Battery
charge, then fully charge, a 2. RAM & CPU Bay
new battery before using it. Cover
Completely discharge and 3. Vent/Fan Intake/
charge the battery at least Outlet

once every 30 days or after
about 20 partial discharges.
See “Energy Star Power
Saving” on page 3 - 10 for
full instructions. Note: the 3.75G/HSPA
USIM Card is located un-
der the RAM & CPU Bay
Cover.

4. Hard Disk Bay
Cover

CPU
The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

System Map: Bottom View - Model B 1 - 17
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Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon 4, and then select Properties if you want to customize the appearance of the Start menu.

‘ Open
Explore

| Search...

| Properties

| Open All Users

m‘ Explore All Users
T

(.

(Qs Default Programs |

#1 Windows Update
<

- oy

E-mall

{1 Programs

=, Documents

B Control Panel

v
|=# Printers
L Taskbar and Start Menu

- "Tues

X0 'gbghéle;_cigs:—éic"_\;/iéw

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

1 - 18 Windows Vista Start Menu & Control Panel



Quick Start Guide

Video Features

You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “ATI Video Driver Controls” on
page B - 1.

To access Display Settings in Windows:

1.
2.

3.
4,
5.

Click Start, and click Control Panel (or point to Settings and click Control Panel).

Click Adjust screen resolution under the Appearance and Personalization menu (or double-click
Personalization > Display Settings).

Move the slider to the preferred setting in Resolution: @ (Figure 1 - 11 on page 1 - 20).

Click the arrow, and scroll to the preferred setting In Colors: @(Figure 1 - 11 on page 1 - 20).
Click Advanced Settings (button) @ (Figure 1 - 11 on page 1 - 20).

To access the ATI Catalyst Control Center (See Appendix B for detailed information):

1.

Click Advanced Settings (button) Q (Figure 1 - 11 on page 1 - 20).

2. Click ATI Catalyst Control Center (tab) e (Figure 1 - 11 on page 1 - 20).
3.
4. You can select Basic or Advanced options on the first run of the control panel (you can select Basic or

Click ATI Catalyst Control Center (button) 6 (Figure 1 - 11 on page 1 - 20) to access the control panel.

Advanced views from the View menu at any time).

Video Features 1 - 19
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Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as
your display device.

K Display Settings % (Multiple Monitors) and ATI Mobility Radean HD 4500 Series Pro,.. [ | |0 chbt™ Conirel Ceder =R~
= = View = §s Hotkeys = 5 Profiles = fif Preferences = g Melp =
Monitor | -

Drag the icons to match your monitors. Identify Monitors

Adapter

Color Management

o [‘w‘u Adeder
ATI Catalyst“" E:M,D;_ [V AT1 Moty Puacoces HD 4500 Sovsee | Dnfonst LCD | -
® o ol £ Desiazp and Desplay Sehe
Control Center -4 b
3 Coer r“"’r —
o™ Vs |
e |
The ATI Catalyst Control Center is used to configure displays Biome L [—

and settings for all your ATI GPUs.

1. (Multiple Monitars) on ATI Mobility Radeon HD 4500 Series o

—ATI Catalyst Control Center -
This is my main menitor

T make changes. &g o aght chck e dapley Dintnct Do
; " Kora.
Extend the desktop onto this monitor

To apen the ATI Catalyst Cantral Center, click on this button: 4 ;
Selecied Display on- AT) Moblty ladeon K 4500 Seces
Resolution: Colors:

[Oelnt L5 {Snge |
Low 0} e High Highest (32 bit 20 ATI Catalyst Cantrol &mm@

Desiog srea Coler qualey Fafresh s
; e =] [ronpoen) =] [ere k|
1024 by 768 pixels P
[Randad Landecace 7 - Force
How do1 get the best display? Advanced Setti 3 )

e ] [ & Lo ][ comad | s e | o | i | |

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest
details on video cards supported.

Figure 1 - 11 - Display Settings & ATI Controls

1 - 20 Video Features
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 17) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Energy Star Power Saving” on page 3 - 10.

S 199+ Cortet et 1 P Oy + e ot =] 4y | Soim 7

5 « Power Options

Battery life: 900
Performance: 999

Battery life: 990900
Performance: : 00

) High performance Battery ffe; 00
Change plan settings Performance: 908800

Note: Sleep is the default power saving state in Windows Vista
Figure 1 - 12 - Power Options

Power Options 1 -21
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Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot

TouchPad and Buttons/Mouse
Audio Features

Adding a Printer

. |
Overview 2 - 1



Features & Components

™ Hard Disk Drive

\ A/

’ﬁl‘ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page C - 3) with a height of 9.5 mm.

Before attempting to ac-

cess any of the internal L .
SO i e The hard disk is accessible from the bottom of your computer as seen below. For fur-

computer please ensure ther details see “Upgrading the Hard Disk Drive” on page 6-4.
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “Storage” on page C - 3). The Sound Volume
optical device is usually labeled “Drive D:” and may be used as a boot device if Adjustment
properly set in the BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto | gows. Click the Volume
the disc tray with label-side facing up (use just enough force for the disc to click onto | icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | check the setting (see
are ready to start. The busy indicator @ will light up while data is being accessed, | Audio Features® on

. L ) . . ; 2-12).
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt- bage )
ed, insert an object such as a straightened paper clip into the emergency eject hole
to open the tray.
©toop Y Figure 2 - 2
== Optical Device

1

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1% Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

gjecta CD (e.g-due to I\ RGR{el[[e)WWIgls)

an unexpected power

LIEERT RS CIER eV« Hold the CD or DVD by the edges; do not touch the surface of the disc.
EEREERCIE SRS  «  Use a clean, soft, dry cloth to remove dust or fingerprints.
f;{g'g}fi?ﬁgrg‘;‘gejﬂg « Do not write on the surface with a pen.

L SENEE el ¢ Do not attach paper or other materials to the surface of the disc.
GNeRETEEE R ETER ¢ Do not store or place the CD or DVD in high-temperature areas.
SUSCRREIEIREESUIIESE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRR e . Do not bend the CD or DVD.

db lodged i -
%ne hofe(?ome =S8l . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 15.

DVD Regional Coding

Table2-1

8 g g S — . .
Region Geographical Location . - : DVD Regional Coding
| General | DVD Region | Volumes | Diiver, | Details|
Most DVDs are sncoded for play in spec Toplay
1 USA, Canada resprilges VI sy el o s ack your BV vt
play discs from that region by selecting @ geograshic arca from the
following fist.
Western Europe, Japan, South CALTION, “Youi i Ghainge the esian 2 rled b of G
2 . . Aiter Changes remairing reaches 6o, you cannet change the region even
Afrlca, M |dd|e East & Egypt i you reinstall Windows or move your DVD drive to a diferent computer.

Changes remaining: 5

South-East Asia, Taiwan, South

To changs the curent regian, sslsct a gsographic arsa, and then dick OK

3 Korea, The Philippines, Indonesia, ,
United Arab Emirates -
Hong Kong Orited Kingdom
Uruguay
4 South & Central America, Mexico, e £
. Watican City -
Australia, New Zealand >
Curert Region: [Not Selected
5 N Korea, Russia, Eastern Europe, Newireosn | edo

India & Most of Africa

6 China

Optical (CD/DVD) Device 2 - 5
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4

Card Reader Cover

Make sure you keep the
rubber cover provided in

the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 -3
Left View

1. Card Reader

7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

* MMC (MultiMedia Card) e MS Duo (requires PC adapter*)
» SD (Secure Digital) * Mini SD (requires PC adapter*)
e MS (Memory Stick) * RS MMC (requires PC adapter™*)

e MS Pro (Memory Stick Pro)

*Note: The PC adapters are usually supplied with these cards.

0 ) L =

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

) =) L— =N

Inserting and Removing ExpressCards

» Align the ExpressCard with the slot and push it in until it locks into place (as
pictured in the generic figure below).

» To remove an ExpressCard, simply press the card to eject it.

4

ExpressCard
Slot Cover

Make sure you keep the
rubber cover provided in

the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

Figure 2 -4
Left View

1. Express Card
Slot

Figure 2 -5
Inserting &
Removing Express
Cards

ExpressCard Slot 2 - 7
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in

Mouse Driver

If you are using an ex- much the same way as a two-button mouse.
ternal mouse your op- . .
erating system may be Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
able to auto-configure can configure the functions by double-clicking the TouchPad driver icon £ on the
_VOUf"mQUSG dU”I“Q Its taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
installation or only en- motion and sensitivity options to your preferences. You will find further information
able its basic functions. )
Be sure to check the at www.synaptics.com.
device's user docu- 7 Mouse Propeies D] [ viouse properies ==}
mentation for details. Buitons | Poirters | Pointer Options | Wheel | Hardwars | ] Devics Settins | Butons | Pointers | meaOmmnsW Hardwars | (] Devics Settings|

r~ Button configuration _ _ _ _ _ 1 Vertical Scrolling

Devices:

v “  Rallthe wheel one noichto scral:
 Lefthanded

& Hghthanded @ e fallowing umber of fines at & e
Figure 2- 6 . :
I g U re - - Primary Click (Mormal Select, - Secondary Click (Context
H gzetba) Mexispect b aa) () One screen at a time
Mouse Properties =
~ Double Click Speed - Herizorttal Scrolling
Double-click the folder to test your setting. if the folder does not B) Tilt the wheel to scroll the following number
open or close, try using a slower setting of characters at & time:
Sl Fast
o 5 & -

- ClickLock
[~ Tum on ClickLock

Enables you to highiight or drag without helding down the mouse butien. To set.
briefly press the mouse button. To release, dlick the mouse button again

2 - 8 TouchPad and Buttons/Mouse
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Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Mouse (Hardware and Sound).

Click Device Settings (tab) and click Settings.

Use the menu tree on the left to access the user configurable settings.

PobNbE

¥ Mouse Properties Q ¥ Properties for Synaptics TouchPad V7.2 on PS/2 Port ‘ g
Buitons | Pointers | Ponter Optiors | Whesl | Hardware{( () Device Settings - Select an ftem :
T |
Seroling
Devices: Finch Zoom
| Enabled | Name T Pon | - Rotating |
Yes ‘Synaptics TouchPad V6.2 PS/2 - Pointing |
- Buttons
Tapping
Application Gestures o
m Synaptics
| Disable Soiven l
~— T Properties window allows you to s yourposding devics. [ ‘
settings. Uss the menu trae to the Ieft to access the customizable 5
~Tray leon Features. These includs singlefinger pointing and scrolling options. plus |
o e R imultifinger gestLres to manipulate documents. obiects. and applications. | =
Remove tray icon from taskbar
Using the Properties Window =
" Statictray icon in taskbar 0 420PM (Cick on a featurs in the menu tree to see a page of descrptions and |
settings forthat feature. Some festures have several pages of sstiings
& Agimated tray icon in taskbar BT 420pM Click on the = (pius sign) next to a feature to see all s related pages. The
settings wil appear in the window to the right of the menu tree. Information
sbout these options and instrutions on haw to change them will appear
www syniaptics com Ihere in this information box. You can use the scroll bar to view the -
w1 :
= i S -

TouchPad and Buttons/Mouse 2 - 9

4

Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu

and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

Figure 2 -7
Mouse Properties -
Device Settings
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Figure2-8
Scrolling Gesture

Figure2-9

Zooming Gesture

Scrolling

The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

(\“\“} \J q\

Zooming

The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

N

l \

2 - 10 TouchPad and Buttons/Mouse
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Rotating

Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another

finger near the middle of the TouchPad and slide it in a circular motion around the

stationary finger (clockwise or counterclockwise) to rotate the object.

| m Figure 2 - 10
- Rotating Gesture
1 K

)

Three Finger-Flick/Three Fingers Down (Press)

The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

!, l,\\ﬂ/ﬁlﬁ - K\\P ﬂ_\ Figure 2 - 11

‘ Flick/Press
/ | / | Gesture

TouchPad and Buttons/Mouse 2 - 11
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Audio Features

You can configure the audio options on your computer from the Sound “ control
panel in Windows, or from the Realtek HD Audio Manager g icon in the taskbar/
control panel (right-click the taskbar gfj icon bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination.

4

Sound Volume
Adjustment

The sound volume level

is set using the volume
control within Windows

[ o 1] Realtek HD Audio Manager == x|
(and the volume func- -n..]]] Sound Manages J&I“ DS
tion keys on the comput- o g - |- ““"““'"““"’“t| €9 ”"”"””""E‘ o
er). Click the volume e Ao Donces
. Main Volume ANALOG
icon in the taskbar to % T L 0 (D)
check the setting. > e e ®
— Windows Media Player O
l Speaker Configuration u@ @
g r[f; Volume Control EE} r g ‘ DIGITAL
i
| .j;é;:. Sound Recorder ] / .
Right-click the icon S
' to access the menu A
;‘hii' above. Virtual Surround
% REALTEK (3]
Figure 2 - 12 —
Realtek Audio
Manager

2 - 12 Audio Features
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

arwbd

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer’'s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Adding a Printer 2 - 13

4

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

P functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
e The Power Sources best to refer to the user’s

« Turning on the Computer EE @ 7o EREE:

ing system.
« Power Plans a
» Power-Saving States (Note: All pictures used
» Configuring the Power Buttons on the following pages

are from the Windows

* Energy Star Power Saving Vista OS.)

» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources

Z The computer can be powered by either an AC/DC adapter or a battery pack.

Silent Mode
Use the WP key to tog- | AC/DC Adapter
gle Silent Mode to re- | Use only the AC/DC adapter that comes with your computer. The wrong type of AC/

duce fan noise and save | 1 aapter will damage the computer and its components.
power consumption.

Note this may reduce | 1 Attach the AC/DC adapter to the DC-in jack on the left of the computer.
computer perfonmance. 2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Energy Star Power Saving” on page 3 - 10.

. |
3 - 2 The Power Sources
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Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow- Z
er button on the front panel. Shut Down

Note that you should al-
When the computer is on, you can use the power button as a Sleep/Hibernate hot- | ways shut your comput-
key button when it is pressed for less than 4 seconds (pressing and holding the power | erdown by choosing the
button for longer than this will force the computer to shut down). Use Power Op- | Shut Down command

. . . . . from the Lock Button
tions (Hardware and Sound menu) control panel in Windows Vista to configure | vicnu in Windows Vis-

this feature. ta. This will help prevent
hard disk or system
problems.

/ Connect To Switch User
Log Off

Control Panel Leck
Forced Off

Default Programs Restart

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow- Help and Support =i

Hibernate

er button for 4 seconds, or longer, to force the system to turn itself off. - Shurt Down
l-'.-ﬁ’ JETINGE

Power Button Sleep

Search

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).

| Windows Vista™

Turning on the Computer 3 - 3
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Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

4

Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L on § y\cond the computer into Sleep after a period of inactivity.

page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

e
33 « PowerOptions » Edit Plan Settings v | 42 [l search 2|

Change settings for the plan: My Plan 1

[EeRr=c=)

5 Power Options

Password

Advanced settings ‘

It is recommended that

Select the power plan that you want to customize, and
then choose settings that reflect how you want your

you enable a password
on system resume in or-
der to protect your data.

® Putthe computertoslecp: (15 minutes ~| [2hour - [On battery: [ L
Plugged in: Ves
- (= Hard disk B
Flgure 3-1 ' C change advanced power settings P | = Tumoff hard disk after
On battery: 10 Minutes
Power Plan

Advanced Settings

3 - 4 Power Plans

Choose the sleep and display settings that you want your computer to use.

j On battery

£ Pluggedin

@ Tum off the display: [5 minutes ] [20 minutes

Save changes

@

@ Change seftings that are currently unavailable

computer to manage power.

[My Created PLan [Active] v

= Additional settings
= Require a password on wakeup

Plugged in: 20 Minutes
[ Wireless Adapter Settings
@ Sleen

Restore plan defaults
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing Y
any reduced performance (especially under DC/battery power).

ATI PowerPlay™

Choose High performance for maximum performance when the computer is pow- || PowerPlay™ in the ATI
ered from an AC power source. Choose the Power saver (bear in mind that this | Catalyst Control Cen-

. ter (in the Graphics Set-
scheme may slow down the overall performance of the computer in order to save e Toen Vi T

power) for maximum power saving when the computer is battery (DC power) pow- | ajiows you to set your
ered. graphics processor set-
tings for higher perfor-
mance or longer battery
life.

[E=EERES)

J S » Comrene s pouwrOgens <o
@

Require a password on wakeup

Select a power plan

Choose what the power .
Power plans can help you maximize your computer's performance or conserve

energy. Make a plan active by selecting it, or choose a plan and customize it by
changing its power settings. Tell me more about power plans

Plans shown on the battery meter
Create a power plan

(7 Balanced Battery life: @20

Choose when to turn off the Change plan settings Performance: @@

display

Change when the computer (0 Power saver Battery life: @90990

sleeps Change plan settings Performance: @@ Figu re 3 2
@ High performance Battery life: @@

pesaly Change plan settings Performance: @@e29@ POWEI‘ P|anS

Personaﬁzatiun
W‘;\Qm Mobility Center

User Accounts

. |
Power Plans 3 - 5
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4

Power Button

The Power Button [}
in the Start Menu (in
Classic View use the
Shut Down button |0])
can be used to send the
computer into a power-
saving state.

Sleep Mode &
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power.

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Log Off
Control Panel Lock
Default Programs Restart
Help and Support Sleep
Hibernate
——
| (V) E = ' Shut Down

Power-Saving States 3 - 7

Power Management

Figure 3- 3
Lock Button Menu
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Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the

Password computer in to a power-saving state.
Protection

It is recommended that
you enable a password
on wake up in order to Define power buttons and turn on password protection

protect your data,. Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans,

@@g@ » Control Panel » Power Options » System Settings

@ Change settings that are currently unavailable

However you can dis-
able this setting from the
Power Options menu
by clicking Require a © whentpressthe power buttor: [sieep = -]

Power and sleep buttons and lid settings

] On battery J Plugged in

password on wakeup X
in the left menu, and se- @ whentprestneseppuon (TS

Shut down

lecting the options (click % When [ clase the lid [Steep -] [slesp -
Change settings that
are currently unavail-
able).

Password protection on wakeup

@ Require a password (recommended)
‘When your computer wakes from sleep, no one can access your data without entering the correct
password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't

Figure 3-4 locked.

Power Options
Define Power Save changes
Buttons

.|
3 - 8 Configuring the Power Buttons
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, 4
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon :D‘/L'J Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

will wake the system up.

Press the Power Button

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) _
Hibernate Press the Power Button Table 3_ 1
Orange (AC/DC adapter) Resuming
Display Turned Off Green Press a Key or Move the Mouse/Touchpad Operation

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down

hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9
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Energy Star Power Saving

This system supports Energy Star power management features that place comput-

ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. If you want to enable Energy Star power saving then follow these in-

structions:

=

Right-click the taskbar iconi_i. |
Select Power Conservation Modes.
3. Select Energy Star to use the Energy Star power management and override other
power saving settings.

Power Conservation Modes |

N

Figure 3-5 —System State
Energy Star Menu

Power Conservation Modes

Power Conservation Modes

" Normal

" Battery Save

(* Energy Star

3 - 10 Configuring the Power Buttons



Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon [ in the taskbar to see the current battery level and charge
status.

B

45 Power Options

Advanced settings

. Select the power plan that you want to customize, and
\]:J then choose settings that reflect how you want your
computer to manage power,

@ Change settings that are currently
[MyPlan1 =

= Battery
Critical battery action

ﬁ 54% available {plugged in, charging)

Select a power plan:
) My Planl

@ Power saver

[ Low battery level

[ Critical battery level

= Low battery notification
On battery: On

() High performance

Plugged in: On

Learn how to conserve power
Maore power options
Windows Mohility Center

= Low battery action

Sieej

Fézfcre plan defaults

Shut down

< Ty = a0 g5 am

Power Management

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3-6
Battery Icon
(Taskbar) & Battery
Advanced Settings

Battery Information 3 - 11
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Conserving Battery Power
2 » Use a power plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.

Center * Lower the brightness level of the LCD display. The system will decrease LCD

The Windows Mobility brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel

provides an easy point | ¢ Reduce the amount of time before the display is turned off.

of access for information

on battery status, power | ¢ Close wireless, Bluetooth, modem or communication applications when they are
plans used and wireless not being used.

device status etc.

» Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

8 Windows Mobilty Cente

A ; Fully charged ( No display
Figure 3 _ 7 &5} [ Mute @ (100%) !_!?_U Connected &_-_. conlnected
. oy Change wireless network settings.
WInd%WS M0b|||ty i) Balanced - [ Turn wireless off ] [ Connect display
enter

Yolume Battery Status Wireless Metwork External Display

Ma sync P .
@ parts:ershipz @& Mot presenting

[ Sync settings I [ Turn on

Sync Center Presentation Settings

3 - 12 Battery Information
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Energy Star
Power Saving” on page 3 - 10 for more information on how to maintain and prop-
erly recharge the battery pack.)

.|
Battery Information 3 - 13
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Proper handling of the Battery Pack
7\[\1’: * DO NOT disassemble the battery pack under any circumstances
« DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

AN
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t

turn off the computer even if a message indicates the battery is critically low, just let 3
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.

2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after saving it) and click Change advanced power
settings.

Figure 3-8
Power Plan Create

Battery Information 3 - 15
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4.
5.

Figure 3-9
Power Options
Advanced Settings -
Battery

Scroll down to Battery and click + to expand the battery options.
Choose the options below (click Yes if a warning appears):

@ Power Options

[P

A=)

@ Power Options

Advanced settings |

Select the power plan that you want to customize, and
then choose settings that reflect how you want your
computer to manage power.

@

WY Change settings that are currently unavailable

[Discharge Battery [Active] -

Advanced settings |

®

¥ Change settings that are currently unavailable

Select the power plan that you want to customize, and
then choose settings that reflect how you want your
computer to manage power.

[Discharge Battery [Active] -

[ Battery A
= Critical battery action
On battery: Shut down
Plugged in: Do nothing
= Low battery level
On battery: 0 %
Plugged in: 0 %
= Critical battery level
On battery: 0 %

Plunaed in (36 1] =

m|

On battery: 0 % -
Plugged in: 0 %
= Critical battery level
On battery: 0 %
Plugged in: 0 %
# Low battery notification
= Low battery action

Plugged in: Do nothing

A e |

Restore plan defaults

Restore plan defaults

Apply

o] (o

I

ok [ ) [ |

Low battery levels = 0%
Critical battery Levels = 0%
Low battery action = Do Nothing

Critical battery action (On battery) = Shut down
Critical battery action (Plugged in) = Do Nothing

3 - 16 Battery Information
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How do | fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
Battery Information 3 - 17
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Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Windows 7 In-
formation” on pageD - 1 for Windows 7
information).

Module Driver Installation

The procedures for installing drivers for the Wireless
LAN, PC Camera, 3.75G/HSPA and Fingerprint
modules are provided in “Modules & Options” on
page 7 - 1.

What to Install 4 - 1
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Driver In Stal | at| on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
Insert the Device Drivers & Utilities + User’s Manual this order) which is the same as that listed in the
disc and click Install Drivers/Option Drivers (button). Drivers Installer menu below.
2. Click to select the driver you wish to install, after
If you wish to install the drivers manually see overleaf installing each driver it will become grayed out. If
4 for the driver path information. you need to reinstall any driver, click the Unlock
button (you should uninstall the driver first).

. 3. Follow the instructions for each individual driver

'Y A : - / s . . . .
| "I\/J-Ob'l.le («’Qlf'i“"-““", o gl;ézléatlon procedure as listed on the following

: '_'I\(iob_i_le ()61}1@{.1[&11

Please follow steps from top to bottom in order to install drivers.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation
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Manual Driver Installation

Driver - Windows Vista with Service Pack 2 Page Click Browse CD (button) in the Drivers Installer ap-
, plication and browse to the executable file in the ap-

Chipset Page 4 -5 . .

propriate driver folder.
Video Page 4 -5
Audio Page 4 - 6 Windows Update

After installing all the drivers make sure you enable
Modem Page 4 -6 . . .

Windows Update in order to get all the latest security
LAN Page 4 -6 updates etc. (all updates will include the latest hotfixes
TouchPad Page 4 - 6 from Microsoft). See “Windows Update” on page 4 -
CardRoader Page 46 7 for instructions.
Hot Key Page 4 -6 /
Wireless LAN Modul Page 7 -7

reiess odure age Windows Vista Service Pack 2
MEI Driver Page 4 -7 . ) ) .
Make sure you install Windows Vista Service Pack 2
3.75G/HSPA Module Page 7 - 25 (or a Windows Vista version which includes Service
i i Pack 2) before installing any drivers. Go to the Micro-

Fingerprint Reader Module Page 7-43 soft website for download details, or contact your service
PC Camera Module Page 7 - 49 center.

Table 4 - 1 - Driver Installation

. |
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

4 - 4 Driver Installation



New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.

Drivers & Utilities

Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click 1.Install Chipset Driver > Yes.

2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video

1. Click 2.Install Video Driver > Yes.

2. Click Next > Install (button).

3. Click the Express (or Custom if you prefer to
manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish > Yes to restart the computer.

Note: After installing the video driver go to the Dis-
play Settings control panel to adjust the video settings
to the highest resolution (see “Video Features” on
page 1 - 19).

Driver Installation 4 - 5
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Audio

1. Click 3.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.

3. The modem is ready for dial-up configuration.

4

Modem Country Selection

Go to the Phone and Modem Options control panel (Hard-
ware and Sound) and make sure the modem country selection
is appropriate for you.

LAN

1. Click 5.Install LAN Driver > Yes.
2. Click Install.

3. Click Finish.

4. The network settings can now be configured.

TouchPad

1. Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license, and then
click Next.

4. Click Finish > Restart Now to restart the com-
puter.

CardReader

1. Click 7.Install CardReader Driver > Yes.

2. Click Install.

3. Click Finish.

Hot Key

1. Click 8.Install Hotkey Driver > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.

It is recommended you now install the MEI Drive (see
over).
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MEI Driver

1.

akrown

Insert the Device Drivers & Utilities + User’s
Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Install MEI Driver > Yes.

Click Next > Yes > Next > Next.

Click Finish.

Windows Experience Index

After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-

ence Index:

1. Click Start, and click Control Panel.

2. Double-click Performance Information and
Tools (System and Maintenance).

3. Click “Update my score”.

4. The computer will take a few minutes to assess
the system performance.

5. Close the control panel.

Drivers & Utilities

4

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point
to Settings and click Control Panel).

2. Click Check for updates (Security), or
double-click Security Center and click
Windows Update.

3. Double-click Check for updates (button).

4. The computer will now check for updates
(you need to be connected to the internet).

5. Click Install now (button) to install the
updates.
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Optional Drivers

See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-

j'i_\/l'obi_]e C51_11m;[i11

&

Please follow steps from top to bottom in order to install Option drivers.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Bluetooth Module

Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 2
for configuration instructions.

Wireless LAN Module

See the introduction in “Wireless LAN Module” on
page 7 - 7, and check the installation procedure.

3.75G/HSPA Module

See the introduction in “3.75G/HSPA Module” on
page 7 - 25, and check the installation procedure.

Fingerprint Reader Module

See the introduction in “Fingerprint Reader Module”
on page 7 - 43, and check the installation procedure.

PC Camera Module

See the introduction in “PC Camera Module” on
page 7 - 48, and check the installation procedure.
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Chapter 5: BIOS Utilities "

OverVieW BIOS Settings
Warning
This chapter gives a brief introduction to the computer’s built-in software: _
Incorrect settings can
Diagnostics: The POST (Power-On Self Test) ;a;ffm)t/,zf ng ifr?;(;:o
mistakes, return to Set-
Configuration: The Setup utility up and restore the Set-

If your computer has never been set up, or you are making important changes to the e SIERTIUEGEE

system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

. |
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4

POST Screen

1.BIOS information
2.CPU type

3.Memory status

4.Enter Setup prompt
appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure5-1
POST Screen

The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

Phoenix SecureCore{tm) HB

Copyright 19§5-2007 Phoenix Technologies Ltd.
All Rights Reserved

BIOS Revision #*ahakkkkhik

KBC/EC Firmware Revision dviddokdd

CPUJ = 1 Processors Detected, Cores per Processor = 49
Genuine Intel {(R) CPU 0&20 @ 1.736Hz
1016M System BAM Passed e

256KB L2 Cache per Processor Core
#192K L3 Cache Detected

System BIOS Shadowed

Video BIOS shadowed

Fixed Disk 0: FUJITSU MHZ2160BH G2
ATAPI CD-ROM: MATSHIBD-CHB UJ130RS
Mouse initialized

Press <F2> to enter SETUP e

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Program
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Setup Screens

The following pages contain additional advice on portions of the Setup. 2
) ] ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet and opfions.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Phoenix SecureCore{tm) Setup Utility

Flgure 5 = 2 - HMain Adranced Security
Main Menu
Item Specific Help
[[E} 54: 171
System Date: [0&F11F2009]
<Tah>, <Shift-Tah>, or
p SATHR Port 1 [FUJITSU MH22150BH ] <Enter> selects field.
» SATA Port 2 [MATSHITABD-CHME 1J13]
- SATH Port 5 [Hone]
System Hemory: 628 KB
BIOS Revision: Ak d A Ak
KBC/EC Firmmare Rewision: dedededededdok
VA Card: Ak d A Ak
VEIDS Revision: A ek
YBIOS Build Date: hkdkh Ak
Help Select Item Change Values Setup Defaults
Exit Select Menu Select #Sub-Henu Sare and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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SATA Port 1/2/5 (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of an HDD/optical de-
vice on the computer’s SATA Port 1/2/5. Use the Auto (Type:) setting to have the
items configured automatically for you.

System Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
This item contains information on the current videos card installed, and on the Video
BIOS version.

Main Menu 5 - 7
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Advanced Menu

Phoenix SecureCore{tm) Setup Utility

m Advanced Security Boot Exit

Item Specific Help

[Enabhled
Boot-time Diagnostic Screemn: [Misabled] Enable support for
Legacy 0S5 Boot : [Enabled] Legacy Universal Serial
Battery Low Alarm Beep: [Disabled] Bus

Figure5-3
Advanced Menu

Change Walues Setup Defaults

Help Select Item
Select FSub-Menu Save and Exit

Exit Select Menu

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus in

non-USB aware operating systems.
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Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or Power-On
Self Test (see “The Power-On Self Test (POST)”” on page 5 - 2).

Legacy OS Boot: (Advanced Menu)

Enable this item to support only system boot from the Legacy OS (e.g Windows Vis-
ta). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the audible warning when the battery has
reached low power status.
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4

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure5-4
Security Menu

Security Menu

Phoenix SecureCore{tm) Setup Utility

Hain Adranced Security Boot Exit

Item Specific Help
Supervisor Password Is: Clear
User Password Is: Clear
Swpervisor Password
(Enter | controls access to the
Set User Password [Enter] setup utility.
Fixed disk boot =sector: [Hormal]
Password on boot: [Disabled]
TPM Support [Dizabled]
Help Select Item Change Values Setup Defaunlts
Exit Select Menu Select FSub-Menu Sarve and Exit

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).
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Set User Password (Security Menu)

You can set a password for user mode access to the PhoenixBIOS Setup Utility.
This will not affect access to the computer OS, (only the Setup utility) unless you
choose to set a Password on Boot (see below). Many menu items in the Phoenix-
BIOS Setup Utility cannot be modified in user mode. You can only set the user
password after you have set the supervisor password.

Fixed disk boot sector: (Security Menu)

If you choose “Write-Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled”), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Boot Menu

Phoenix SecureCore{tm) Setup Utility

Figure 5 - 5 TR ... T

Boot Menu

Item Specific Help
Boot priority order:

: IDE HDD: FUJITSU MHZ2160BH G2- (51} Keys used to view or
: USE HDD:

2

] configure devices:

4: USE EEXY: Up and Down arrows
5 5: PCI BEY: JMC25x Gigabit Ethernet Co select a device.

6:

1

8

<+> and < - moves

the device up or dovm.
: <x= exclude or include

Excluded from hoot order: the device to boot.

: USB FDC: <Shift + 1> enables or

: USE CDROM: dizables a device.

: USB ZIP: <1 - 4> Loads default

: USB LS120: boot gequence.

: PCI SCST:

: Other USB:

HI L9 v
Help Select Item Change Walues Setup Defaults
Exit Select Menu Select FSub-Menu Sare and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.
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Phoenix SecureCore{tm) Setup Utility F
igure 5 - 6
Main Advranced Security Boot Exit g i
Exit Menu
Item Specific Help
Exit Discarding Changes
Load Setup Defaults Exit System Setup and
Digcard Changes save your changes to
Save Changes CHMOS .
Help Select Item Change ¥alues Setup Defaults
Exit Select Menm Select #Sub-Menu Sarve and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview

| ins informai | L
This chapter contains information on upgrading the computer. Follow the steps out- —
lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your

« A small crosshead or Phillips screwdriver service  representative

. before undertaking an
» Asmall regular slotted (flathead) screwdriver upgrade procedurges tz)/

* An antistatic wrist strap find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

. |
Overview 6 - 1



Upgrading The Computer

Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* You don’t have all the necessary equipment

* You’re not in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2N\
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’Ll\ _

it is best to remove the battery. Warranty Warning
Turn the computer off, and turn it over. Please check with your
Slide the latch @ in the direction of the arrow. service representative

Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any

Slide the battery out in the direction of the arrow @. ?pgradf.fﬁ;?ced.ﬂrs/% Itlg
Ind out | IS WI

your warranty.

PwnE

Figure 6 -1
Battery Removal

.|
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Upgrading the Hard Disk Drive

SN
’Ll\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
HDD System disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
SUELUIRE operating system’s installation instructions, and install all necessary drivers and util-

N Rl el ties (See “Driver Installation” on page 4 - 2), when setting up a new hard disk.

fore you begin make sure: )
You have backed up any 1. Turn off the computer, and turn it over and remove the battery.

data you want to keep from 2. Locate the hard disk bay cover and loosen screws @ & @.

your old HDD. 3. Remove the hard disk bay cover @.
You have all the CD-ROMs

and FDDs required to in-
stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Model A . Model B

Figure 6 - 2
Hard Disk Bay
Cover Removal

6 - 4 Upgrading the Hard Disk Drive
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4. Grip the tab and slide the hard disk in the direction of arrow @.
5. Lift the hard disk out of the bay @.

Model A

Figure 6 - 3
HDD Assembly
Removal

Upgrading the Hard Disk Drive 6 - 5
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6. Remove the screw(s) @ (for Model B only) and the adhesive cover @.
7. Reverse the process to install a new hard disk drive (do not forget to replace all the
screws and covers).

4

Hard Disk Screws &
Cover

The hard disks and cov-

Figure 6 - 4 ers pictured here may
HDD Cover appear slightly different
Removal from your model design

(these designs are sub-
ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.
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Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and loosen screws @ & @.
3. Remove the hard disk bay cover @.

Figure 6 -5

Removing the HDD
Cover a

Upgrading the Optical (CD/DVD) Device 6 - 7
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4. Remove the screw at point @@, and use a screwdriver to carefully push out the
optical device at point @.
5. Reverse the process to install the new device.

Figure 6 -6
Removing the
Optical Device

6 - 8 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws @ - @.

Figure 6 - 7
CPU/RAM Bay

Model B Cover Screws

.|
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3. Carefully (a fan and cable are attached to the under side of the cover) lift up
_Zl’_ the bay cover.

e 4. Carefully disconnect the fan cable @, and remove the cover @.
Fan Cable & Cover

Make sure you recon-
nect the fan cable 4
before screwing down
the bay cover. Note the
information on replacing
the RAM & CPU bay
cover in

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

Figure 6 - 8
CPU/RAM Bay
Cover Removed
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5. Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 9.

6. The RAM module will @) pop-up, and you can remove it.

7. Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly

into the memory slot.

Figure 6-9
RAM Module
Removal

* 1GB 2Rx16 PC3~-10600S-9-00
HMT11286AFPEC - HIND AA

4

Single Memory
Module Installation

If your computer has a
single memory module,

then insert the module
into the Channel 0
(JDIMM1) socket. In this
case this is the lower

. . . . . memory socket (the
9. The module’s pin alignment will allow it to only fit one way. Make sure the module el @eEs: 9 e

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit mainboard).
without much pressure.

Upgrading the System Memory (RAM) 6 - 11
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10. Press the module in and down towards the mainboard until the slot levers click into

/ : place to secure the module.
11. Replace the bay cover (see sidebar and below for Model A Computers) and
Cover Pins screws (make sure you reconnect the fan cable before screwing down the
bay cover).

Note that there are cov-
er pins need to be

aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover
(see Figure 6 - 10).

Model B

©0 © o

Figure 6 - 10
Cover Pin
Alignment

©

12. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

6 - 12 Upgrading the System Memory (RAM)



Chapter 7. Modules & Options

Overview

This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

* Bluetooth Module

»  Wireless LAN Module

e 3.75G/HSPA Module

» Fingerprint Reader Module
e PC Camera Module

2N\Z
A

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
guency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

. |
Overview 7 - 1

Modules & Options

2NZ
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Important Notice

If your purchase option in-
cludes both Wireless LAN
and 3.75G/HSPA modules,
then the appropriate anten-
nas will be installed. Note
that In order to comply with
FCC RF exposure compli-
ance requirements, the an-
tenna must not be co-
located or operate in con-
junction with any other an-
tenna or transmitter.




Modules & Options
Bluetooth Module

\ A/

. ’Ll‘ _ The operating system’s Bluetooth Devices control panel is used to configure the

Wireless Device Bluetooth settings in Windows Vista, and therefore does not require a driver. Use

Operf.'on A]:tboard the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 -
LS 13) to toggle power to the Bluetooth module. When the Bluetooth module is pow-

The use of any portable ered on, the ¢ LED will be orange and the on-screen indicator will briefly be dis-
electronic transmission de- |

: S played.
vices aboard aircraft is usu-

ally prohibited. Make sure
the module(s) are OFF if

4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.

7 - 2 Bluetooth Module
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Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it 4

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Bluetooth Taskbar

2. Make the device discoverable (to do this check your device documentation). lcon

To Turn the Bluetooth Module On If you cannot see the

1. Press the Fn + F12 key combination to power on the Bluetooth module. Bluetooth icon in the task-

2. A Bluetooth icon EJ will appear in the taskbar (see sidebar). bar, access the Blue-

3. You can then do any of the following to access the Bluetooth Devices control tooth  Devices  control
panel. panel. Click Bluetooth

Settings > Options, and

make sure that Show the
Bluetooth icon in the
notification area check
box (Connections) has a
tick inside it.

«  Double-click the icon EJ to access the Bluetooth Devices control panel.
e Click Start, and click Control Panel (or point to Settings and click Control Panel), and then
click Bluetooth Devices (Hardware and Sound).

« Click/Right-click the icon gg and choose an option from the menu.

Add a Bluetooth Device
Show Bluetooth Devices Note that you will need to
check the LED indicator
to see if the module is
pekeNe e powered on or not.

Send a File

Join a Personal Area Metwerk

Add Wireless Device Bluetooth Settings Open Bluetooth Settings ]
Figure 7 -1
— Remove Bluetooth Icon Bluetooth Devices &
g Click Icon Menu

Bluetooth Module 7 - 3
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To Add a Bluetooth Device

/ 1. Access the Bluetooth Devices control panel and click Bluetooth Settings.
o _ 2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to
Pairing Options this computer check box (Connections) has a tick inside it, and click OK.

3. Click Add Wireless Device in the Bluetooth Devices control panel.

If a device has b - . . S
s 4. Double-click the device you want to pair with the computer.

viously connected then
the pairing option menu
will appear when you at-

Pair with a wireless devic,

tempt subsequent con-

Feﬁtloni.hYou Gl (tIhOOSE | Select a wireless device to pair with this computer

o0 have the computer cre-

ate a pairing code for you, _Nam; Device Cat..

use the device's existing LW Phone M| wess

pairing code or you can | 8] _suoan | @ shsos

pair certain devices with- ‘A W G

out using a code L Bluetooth ;“i Bluetooth
a Phone

3 i Bluetooth

Figure 7 - 2
Pair with a wireless
device l

What should I do if Windows hasn't discovered my device?

=

5. Onfirst connection the computer will provide you with a pairing code to be entered
onto the device.

7 - 4 Bluetooth Module
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6. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

Type the following code into your device L. Figure 7 - 3
Thes will vy that you ane painng with the comect device. Palrlng COdeS Palrlng Code
68242645 The example outlined here shows a connection to Example
e eoypenc o e a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
g v dure, and may require you to confirm a pairing
o code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
7. Windows will check to see if any drivers are required to complete the pairing.
8. Follow any on-screen instructions on the computer if device drivers are required to
be installed.
9. Click Close.
sz e Figure 7 - 4

Pairing Complete &

Bluetooth Device

Enabled

[ ol o Mo S 1 i

Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
/ + 1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

« Change the name of the device (click General, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth

g‘;"zg“i‘lz’; :gld Zﬁz To Make your Computer Discoverable to Bluetooth Devices
< ¢ 1. Access the Bluetooth Devices control panel.

Support from the Start ; . .
menu. Type Bluetooth in 2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth

the Search Help box, and devices to find this computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
€} Bluetooth Radio Properties =)
Discovery
[F]liow Bluetooth devices to find this compltert
& To protect your privacy, select this check box only
when you want a Bluetooth device to find this
Flgure 7 - 5 gzising\iema&vdevl(asmgunne(th:thlsmmputer
B | u eto Oth Setti n g S _ lﬂAlErtmE when a new Bluetooth device wants to connect
O p t I ONs 7] show the Bluetooth icon in the notification area
Change settings for 3 Bluetooth enabled device,
e || e e
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Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5300 Series, Intel® Advanced N Wi-Fi
Link 6200, Intel® Ultimate N Wi-Fi Link 6300, 3rd Party 802.11b/g or 3rd Party
802.11b/g/n WLAN module in your purchase option, make sure that the Wireless
LAN module is on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 13) to toggle power to the Wireless LAN module. When the WLAN module is
powered on, the (¢) LED will be green and the on-screen indicator will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3.

The standard driver installation procedure for the Intel® Wi-Fi Link Series module
is outlined overleaf. If you want to include Intel® My WiFi Technology as part of
the installation procedure, DO NOT install the driver as per the instructions
overleaf, instead see “Intel® My WiFi Installation & Configuration” on page 7 -
12.

If you have installed the standard driver (as per the instructions overleaf) and wish
to enable Intel® My WiFi Technology at a later point you will need to reinstall the
driver (choose Unlock from the Drivers Installer menu). Follow the driver installa-
tion procedure and choose Modify from the menu when the option appears, and then
follow the remaining installation instructions in “Intel® My WiFi Installation &
Configuration” on page 7 - 12.

Wireless LAN Module 7 - 7
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N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).




Modules & Options

4

Intel(R) PROSet/
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All  Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).

Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1.

SouhrwN

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Next > Finish.

3rd Party 802.11b/g/n or 802.11b/g/n Driver Installation

1.

IS e

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

. |
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon [, and then click Connect to a network (or right-
click the icon B, and then click Connect to a network).

Figure 7 - 6
CConnectto a network > Taskbar Men us

Turn on activity animation

Mot Connected

:, Wireless networks are available.

> Turn pff notification ofn networks
* Click icon Right-e1i¢k ieon
D\agnoseand repair
onnect to a network . /
NETT ST TS Srier MNetwaork and Sharing Center

Network and
Sharing Center

2. Inthe Show list, click to choose Wireless from the drop-down menu.
3. Alist of currently available networks will appear.

You can also use the Net-

) e
(L) % comeatioaneruont I q work and Sharing Cen-

ter control panel in
Windows (Network and

Select a network to connect ta

" L] Internet) to connect to
8 G S Lm ol any available wireless
. networks.

Ky e Security-ensbled netwark ol |

5- WLAND Security-enabled netwark Al
Figure 7 -7
Connectto a

Network
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Click a network, and then click Connect.

If you do not see a network you want to connect to, click Set up a connection or
network (a list of options will appear allowing manual searching, and creating a
new network).

o P P
o) ¥ Connectin a network @ W Connect 1o 2 network ﬁ

Connecting to WLAN Choose a connection aption

o~

Figure 7 - 8 ,
Connecting Ad '™ @ S tens

[Ca Manusily connect ta a wireless netwark
L

& Serup s wireless ad hoc (computer-te- comp

3 St up & dal-up cmnection

(o] (s ] [ Conee ]

6. Move the cursor over the taskbar icon B to see the connection status (see below).

Currently connected to

_ ‘. Metwork.com{WLAMNL) al
Figure 7 -9 up~ Access Local only l_l!!_u
Connection Status -

0 IR 0 1120 AM
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7. Todisconnect from the wireless network you can click the taskbar wireless icon [&J,
and then select Connect or disconnect to access the network menu, and click 7£l<
Disconnect (or right-click the icon B, and then click Disconnect from).

Security Enabled

Currently connected to: = Networks
Connect to a network . -~ A
f = B
s R‘::":gkf;r:l(ownll‘mn !!!‘_'U You should try to make
|| . ClICk iCOI’]}r Disconnect or connect to another network sure that any network you
- how @ ) are connecting to is a se-
onnect or disconne
<CEnnect or disconnedt> 7 cure network.
Network and sharing Center = —
ﬁ WLANI Connected =
Connecting to unsecure net-

works may allow unautho-
rized access to your
Security-enabled network !ﬂ]] T computer, documents, web-

sites and files etc.
Set up a connection or network
Open Netwerk and Sharing Center

B

Security-enabled network

» Figure 7 - 10
Disconnecting

Metwork.com{WLANT) Disconnect from

onnect to a network

Turn on activity animation

Turn off notification of new networks

Right-click icon

Diagnose and repair

P — Network and Sharing Center

Wireless LAN Module 7 - 11
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Intel® My WiFi Installation & Configuration

a Intel® My WiFi Technology uses your WLAN module to allow you to connect up
to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell
phones, handheld devices etc.) to your computer (similar to Bluetooth), while still
To get help on Intel® © connecting to the Internet through your WiFi wireless connection. Intel® My WiFi

My WIiFi configuration £ Tachnology offers greater range and speed than other personal area networks, and
and settings, access the . .
Intel® My WiFi Utility does not require an access point.
from the Start menu

(Start > Programs/All

Programs > Intel

PROSet Wireless > Intel

My WiFi Technology), or

by clicking the taskbar

icon @ Click the Help

icon W#H=p and select

a help topic from the

Contents menu.

Intel® My WiFi Help

. |
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Intel® Wi-Fi Link Series My WiFi Driver Installation

If you see the message “Found New Hardware” click Cancel to close the window. 4
1. Make sure the module is powered on, then insert the Device Drivers & Util- Intel(R) PROSet/
ities + User’s Manual disc into the CD/DVD drive. Wireless
2. Click Option Drivers (button).
X ) A th Intel
3. Click 1.Install WLAN Driver > Yes. Pﬁfggf;t Wire?ess tQO‘fS
4. Click Next > Next. (Statistics and Diagnos-
5. Click the button to accept the license and click Next > Next. tic tools) from the Start
6. Click Custom (button) and click Next. menu (Start > Pro-
7. Click Intel(R) My WiFi Technology (button) and select “This feature will ?;?:S/ﬁg Ogg?raﬁesz
be installed on local hard drive.” R R R S
"1 Intel(R) PROSet/Wireless WiFi Software = and statistical informa-
CEmasey inteD tion only (use the WLAN

Select the program features you want to instal.,

control in Windows Vis-
Click on an icon in the list below to change how a feature is installed. ta. tO ConneCt tO a WLAN

Feature Desaription

5 % Intel(R) WiFi Link Driver T ey o access p0| nt) .

7] Intel(R) PROSetMireless Vi Software R R R
- &3] Intel(R) PROSetjWireless Wi Connection Uity | devices to your computer ina
- - E T vl néwerk,aprt

| = This feature will be installed on local hard dive.
=98 This feature, and all subfeatures, will be installed on local hard drive.

.x This feature will not be available. Figure 7 _ 11

Intel(R) PRO Set

E Intel(R) My WiFi
froel Technology

Ci\Program Files\Intel\

. o Installation
8. Click Next > Finish.

Wireless LAN Module 7 - 13
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon .

2. Click Enable [W=5)
devices listed).

(on the first run of the program there will be no connected

23 e Wy W iy Corl S | D s iy i hay el )
Intel* My WiFi Technology i Intel* My WiF Technology
Disabled r Ensbled (o
7 Figure 7 _ 12 L. L 3 . Tedtvoiagy, Once erabied, lmrt\swvmlhmmnﬁ;'nl\r‘n&wﬁ-.&v—--.ldmw m’l
Intel® le WiFi o ' i s Profie: e Virelsss PA Metwork fame: BteHPTSSL =
e - e
Utlllty To view svalible W devices, snabils Inted®) My Wi Technology. Contacted Davices {]

Mo devices are curvently connected.
T conmect & e devicn o this compuber, cick Add tew Dirvion.

o previously comnected devices o display.
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3. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

4. Click Network and Sharing Center (Network and Internet).

5. Click Manage Network Connections.

[ I e T e e

e

Click Manage Network

Connections — |8 Figure 7 - 13

Network and
Sharing Center

6. Right-click Intel WiFi STA (Station) in Network Connections and select

Properties.
N:;c,,‘q,,_::;;““”:memm ) Conmectrity Metwerk Categary i Owner Type Mlul..ﬂ Figure 7 _ 14
e T I - R Intel WiFi STA
Right-click Intel WiFi STA | & et comean =

o i : Coseecs pinsics Properties
(Station) and select Prop- | scuwsusmes , - (Network

erties.  —— | By e Connections)
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7. Click Sharing (tab) and select “Allow other network users to connect through
this computer’s Internet connection”.

8. Select Intel My WiFi PAN under Home Networking Connection.
9. Click OK.
"' Intel WiFi STA Properties (==
. |Ne¢workjng Sharing |
Click “Allow other network
users to connect through e Comenan Sen
this computer’'s Internet [¥/] Allow cther network users to connect through this
connection” computer'’s Intemet connection
' \§ Home networking connection:
A el PAN .
Select Intel My WiFi PAN. e ALl . _ 7
. Select a private network connection
Flgure 7 - 15 \ []4 Local Area Condion
. i
Intel WiFi STA E —
Pro perties _ Using ICS (intemet Connection Sharing)
Sharing
[ ok ][ Cancsl
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10. A message will appear to inform you that the LAN adapter will be set to use the IP
address 192.168.0.1.

) . . Figure 7 - 16
11. Click Yes to enab.!e Internet Connection Sharing. ’ IP Address
Locel Netuwork e Warning
OB When Internet Connection Sharing is enabled, your LAN adapter will be
set to use IP address 192.168.0.1. Your computer may lose connectivity _\ /_
it Db, yoo S st them b aan v B e /Zl\
automatically. Are you sure you want to enable Internet Connection
Sharing? IP Addresses
= The Intel® My WiFi de-
fault gateway IP ad-
12. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All dress is 192.168.0.1.
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking DO NOT use this ad-

dress for any Wireless
Access Point (or any
other static IP address
on your network).

the taskbar icon E8.
13. Click Profiles B

;r::‘.-l::meM Betwork ame:  IitebCP-73521 @ Figure 7 - 17
e e . Intel® My WiFi
R e e T Utility

o previousty comnectad devices b dicplay.

Wireless LAN Module 7 - 17



Modules & Options

Figure 7 - 18
Profiles

Figure 7 - 19
Intel® My WiFi
Profile Settings -
General

14. Click Profiles, click Intel Wireless PAN and click Edit.

Profiles

nted Wirekess PAN

P Inbef My WIS Techvaskogy seffings are saved as prefies o
o 7 15 bl wedtch ot e thrga o s st My W Ptk

|

15. You can change the Profile Name and Network Name to your personal

preferences in General (tab).

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure 7 - 14 on page 7 -
15).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.

7 - 18 Wireless LAN Module

Profile Settings ren
General | security | sharing | Advanced|

Profile Name:

Intel Wireless PAN

Network Name (S51D):

My Notehook Computer

The Profile Name is the name for the Intel® My WiFi Network as it is displayed on this

computer (Example: Home or Office). The Network Name (SSID) is the name that a

device will see when connecting to this netwark.

=
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16. Click Security (tab).
17. Change the Security Type to WEP and the Encryption Type to 64bit.
18. Enter a password (5 characters long) in the Passphrase box.

=
Profile Settings Wrep

| General | Security iSharing I Advanced |

Security Type: [WEP ) v]

Encryption Type: @4 hit ) v]

pessuard Figure 7 - 20

Use & passphrase to guickly generate a new key or manually enter a key below. |nte|® My WiFi

Passphrase: (5 ASCII characters) Profile Settings -
Security

Key {(0-2,A-F):
3132333435

Key Index: 1 -

Wireless LAN Module 7 - 19
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19. Click Sharing (tab).

20. Make sure Filter Network Traffic and DHCP and DNS Server are Disabled.

Profile Settings

=
@Help

| General | security | Sharing : Advanced

Set Filter Network
Traffic & DHCP
and DNS Servers

to Disabled. <7
Figure 7 - 21 L
Intel® My WiFi
Profile Settings -
Sharing

Filter Network Trdic; ‘

Internet Connection Sharing and Bridging Filter

This setting prevents devices connected to the Intel® My WiFi Metwork from accessing
shared networks through internet connection sharing or network bridging.

DHCP and DMS Servers

en enabled, the Intel@ My WiFi Network will issue IP addresses and resclve device
connected devices. Disable if other DHCP and DNS servers are available on
this network?

DHCP and DNS Servers:( Disabled 2 -

Mote: DHCP and DNS servers are automatically disabled when the network is shared
through internet connection sharing.

7 - 20 Wireless LAN Module
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21. Click Advanced (tab).
22. Make sure the Default Channel is set to Channel 1, 6 or 11.
23. Click OK to save all the settings and click Close to exit Profiles.

==
Profile Settings @rep

| general | security | sharing | Advanced

Default Channel

The channel of the Intel® My WiFi Network will automatically match the associated access
point, If the adapter is not assodated to an access point, the following settings are used for
Intel@ My WiFi Technology:

DefauItChanne F|gure 7 _ 22

1

. Intel® My WiFi

t Profile Settings -
— Advanced

vV
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Figure 7 - 23
Intel My WiFi PAN
Network
Connection Details
(Network
Connections)

24. Double-click Intel My WiFi PAN (Personal Area Network) in Network Connections.

25. Click Details to display the Network Connection Details.

=2 Eel

{ -U-|§u < Network and Internet » Network Connections »

W Organize

-4

2]

[ search

blethis network device b=y Diagnose this connection 5%

Name Status DeviceName  Connectivity  Metwork Category  Owner Type Phone # o ..
&
Intel WiFi STA ~_/ Local Area Connection
N ected LNE
®
offl] Intel My WiFi PAM Status "
General
Connection i E i
_ o MNetwork Connection Details ==
IPv4 Connectivity: Limited
IPvE Connectivity: Limited Network Connection Details
Media State: Enabled Property Value
SSID: MY PAM Connection-specific DN
o Duration: 04:12:34 — Description My WiFi PAN
soeed: 54.0 Mby Physical Address D0-16-EA-DB-61-07
peadi TS DHCP Enabled No
Signal Quality: IPv4 [P Address 192.168.0.1
A IPv4 Subnet Mask 255.255.255.0
([ Details. .. ]1 Wireless Properties ] IPv4 Default Gateway
IPv4 DNS Server
Activity 1Pwd WINS Server
- NetBIOS over Tepip En Yes
Sent —— &_.‘ - Received Linkdocal IPvE Address fe80:.dcd1:6e63:9df5:4afc %21
Ndﬂ] IPvE Default Gateway
Packets: 0 0 IPvE DNS Server
[ @Erope(ﬁes ] [ [f.lgisable 1 [ Diagnose ]
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26. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon E.

27. To add a new device follow the instructions in the devices’ user guide for
connecting to a WiFi network.

28. Click Add New Device in Intel® My WiFi Utility to confirm the security settings
detail.

3 Intel® My WiFi Utility r@w'

Intel® My WiFi Technology

u Add New Device

Enabled

Compatible WiFi devices can now connect to your computer via In) Manually configure a device
devices as wel as a list of devices that previously connected to th

To add a new device, follow the instructions in the device's user guide for connecting to a WiFi

Profile: MY PAN Network Nami netwark using the following security settings: F i g u re 7 - 24
Intel® My WiFi
% Block Device == Delete Devi Network Name(SSID): My Notebook Computer . y
Utility
(Add New Device)

Connected Devices (0] Security Type: WEP

No devices ar¢
Encryption Type: 64 bits
To connect a new device to
Security Passphrase: 12345
Previously Connected Devices (1)
o= = Security Key: 3132333435
Unnamed Device
00:22:43:92:FD:95
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Figure 7 - 25
Windows Mobility
Center

Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon
menu.

L to access the network

Fully charged
(100%)

!!!ﬁ‘ Connected lﬁ. Moy che ay

connected
_[ Change wireless network settings. L

Balanced - [ Turn wireless off l I [ Connect display

Yolume Battery Status Wireless Metwork External Display

W Mot presenting

Mo sync
partnerships

’ Sync settings ] ’ Turn on

Sync Center Presentation Settings
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3.75G/HSPA Module

If you have included an optional 3.75G/HSPA (High Speed Packet Access) module Z

(see “Communication” on page C - 3 for specification details) in your purchase op- | 3.75G/HSPA Module
tion, you will have the appropriate application (HSPA Modem Interface or Mobile Options
Partner) provided for your particular module. Follow the instructions on page 7 - | tpere are two optional
27 to install the USIM card (supplied by your service provider), and then install the | 3.75G/HSPA  modules

application (see over for further details). EZ?n'?ﬂSr f°:n‘c:‘ése | :e”‘g c"r:
\ A/
2 &

module is supplied with the
appropriate application
Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

software.

The module type supplied
may depend upon the com-
puter model purchased.
Check with your service
center for details.

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
guency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.
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4

3.75G/HSPA
Modules & System
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.

Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn + [Z ] key combination (see “Function/Hot
Key Indicators” on page 1 - 13) to toggle power to the 3.75G/HSPA module.
When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be
displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3. Note that exiting the application does NOT turn off the 3.75G/HSPA
module.

* HSPA Modem Interface - See “HSPA Modem Interface Installation” on
page 7 - 29 for driver installation information and “HSPA Modem Interface”
on page 7 - 30 for instructions on using the HSPA Modem Interface.

» Mobile Partner - See “Mobile Partner Application Installation” on page 7 -
38 for driver installation information and “Mobile Partner Application” on
page 7 - 39 for instructions on using the Mobile Partner application.
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For Model A
1. Turn off the computer, and turn it over and remove the battery. ;Zl’;
2. Locate the SIM card cover and loosen screw @. P Saf
3. Remove the SIM card cover @. ower Safety
Warning
For Model B
. Before you undertake
1. Turn off the computer, and turn it over and remove the battery. any installation proce-
2. Locate the RAM & CPU bay cover and remove screws @ - @. dures, make sure that
3. Carefully (afan and cable are attached to the under side of the cover) lift up you have turned off the
the bay cover. power, and disconnect-
4. Carefully disconnect the fan cable @ and remove the cover @ ed all peripherals and

cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

2N
I

Fan Cable

™ 1

Make sure you re-

connect the fan cable
6 before screwing
down the bay cover.

Figure 7 - 26
SIM Card Cover/
RAM & CPU
Bay Cover Removal

3.75G/HSPA Module 7 - 27



Modules & Options

Insert the USIM card as you would into your mobile phone.

6. Slide the SIMLOCK towards the hinge (in the opposite direction to the arrow
illustrated in Figure 7 - 28) in order to release the lock and lift it up.

7. Insert the USIM card as illustrated in (Figure 7 - 27) and close the SIMLOCK.

o

Figure 7 - 27
Insert the USIM
Card

8. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 28 until
Figure 7 - 28 it clicks into the lock position.

SIMLOCK Lock

4

Cover Pins

Note that Model B has
cover pins that need to be

aligned with slots in the
case to insure a proper
cover fit, before screwing
down the bay cover. 9. Replace the covers and screws (reconnect the fan cable before screwing down

the bay cover for Model B computers - see sidebar for note on cover pins).
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HSPA Modem Interface

\ A/

With the 3.75G/HSPA module and USIM card (supplied by your service provider) 7£l<
installed you may then install the HSPA Modem Interface. The HSPA Modem In- Wireless Device

terface allows you to directly access your HSPA internet service from the computer. Operation Aboard
Aircraft

HSPA Modem Interface Installation
. . . . . The use of any portable
1. Enable power to the module by pressing the Fn + [ ] key combination (give electronic transmission de-

the module about 10 seconds to power on and the on-screen icon will indi- Vilfes abﬁ-ﬁ-rfj Zif?\;afli is usu-
cate the module’s power status). _ _ _ the odule) are OFF f
2. If a Found New Hardware window appears, click Cancel in all windows you are using the computer
that appear, and then proceed to install the driver as below. RN S
3. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/ Use the Fn + B key com-
DVD drive. bination to toggle power to
4. Click Option Drivers (button). thed 3575?;5?/*(1,"12“'?-
H H and chec e Inaicator to
5. Click 3.Install 3G Driver > Yes. see if the module is pow-
6. Click Next > Install. ered on or not (see
7. Click Finish to restart the computer. /
8. Access the HSPA Modem Interface from the Start menu (Start > Pro- )

grams/All Programs > HSPA modem), or by double-clicking the HSPA
modem icon on the desktop.

|
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HSPA Modem Interface

a "\ The connection information is stored on the USIM card supplied by the service pro-
vider.

HSPA Modem Help

To get help on 3.75G/ 1. Power on the 3.75G/HSPA module using the Fn + key combination.

HSPA module configu- 2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All

ration and settings, click Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop

the help icon [ icon Pz

select Help. 3. IfaUSIM card is not installed then a message will appear to notify you of this (click
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to
enter a pin #. (Note: to change pin # go to Settings and click OK in PIN
code.)

5. Click the Network connection [
window will display Connection Manager.

Figure 7 - 29 Connection Manager
HSPA Modem
Interface Window The connection information is commonly stored on the USIM

card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect to connect to your service provider.

2 HSPA modem

Figure 7 - 30
Connecting to
Network

Network connection

7. The message “Network is connected” will be displayed when the network
connection is successful.

Figure 7 - 31
Network is
Connected

s =

n I
I 5w |
F Jiten
r |
r I
I Fa I
I e frae |

e
8. You can then access the internet, download e-mail etc. as per any internet

connection.

|
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9. While you are connected the upper right corner of the HSPA Modem interface will
display the upload and download rates, and the taskbar icon will display the

Figure 7 - 32 connection speed.
Uploading/ 36
Downloading Rates
and Speed
10. To disconnect click the Disconnect icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn + [Z] key combination
to turn it off.
Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection [, and click Profiles (tab).
ode -
Figure 7 - 33
Profiles

i
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4,

Click Add (button) and input any Network Settings required by your service

provider.
Click OK to save the profile.

Network Settings
MName: !l
Primary DMS: 0 .0 .

Secondary DNS:

APM Mame: I

IP Address: o0

Username; I
Password: l

Authentication: ’NUHE j'

‘B HSPA modem

Network connection

Connection Manager

= e

Connection Log

Apply

5. You can Edit or Delete profiles from the Profiles tab.

6.

To use a profile click to select it, and then click Apply (button) and the settings will
be transferred to Connection Manager.

Modules & Options

Figure 7 - 34
Network Settings &
Profiles
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Contacts

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts (button).

B HSPA modem

Figure 7 - 35
Network Settings &
Profiles

@N Mt o
Contacts il
“MwPhoneBook
Storage ] Name: J Phione Murnber
@ S Eric @ 0933109428

[l S1M Zoe @ 0924526715
= 51 Shane @ 0227993500

3. Click Refresh (button) to download the contacts from the USIM card to the
computer.

4. The Contacts will then be displayed.

5. Double-click any contact to edit the information (or right-click and select Edit).

6. You can also Export/Import contacts by clicking the appropriate button.
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Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All /
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon. )
2. Click Messages | (button). SMS Service
2 HSPA modem In addition to standard in-
: 00 ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.
=3 sMs | Time [ sender E
i 8 Inbox (12) | &Y 2008/10/16 18:35... 0936019801
%] Outbox 2008/10/1711:02...  +886931181825
8 Sent 2008/10/17 14:50... +886936010399
i ﬁ Draft @ 2008/10/1916:58... 0936019801
@l Personal Folder| () 2008/10/1916:58... 0936019801 |
@ merom i, st H Figure 7 - 36
e B Network Settings &
@2008/11!2417:01.. +886931188820 !_-I PrOfI'GS
Forward
Delate
3. Click Refresh (button) to download the messages from the USIM card to the
computer.
4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To

(button) to select the contact from the list.

3.75G/HSPA Module 7 - 35



Modules & Options

6. Click to select a contact from the list and then click Add (button) and the phone
number will automatically be added to the recipient field.

7. Type the message information into the message body and click Send (button) to
send it, or Save to draft (button) to save the message.

8. Select any message to forward or delete it, or to reply to it.

Settings

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings (button).

Figure 7 - 37

Settings

" Network Mode

PIN code

@ PINL
 PIN2

Others

& My number
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Click OK alongside any of the options to configure the settings.

The Network can be configured for an Automatic (usually from the USIM card) or
Manual connection.

The Network Mode can be configured for any appropriate mode required.

Network Mode
Figure 7 - 38
& Automatic & Automatic Settings - Network/
€ Manual " 26/GPRS/EDGE Network Mode
€ 3G/HSDPA/HSUPA/HSPA

You can also change your settings for the Pin #, and input your phone number.
Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will
need to press the Fn + [Z] key combination to turn off the module (pay careful
attention to this aboard aircraft - see “Wireless Device Operation Aboard
Aircraft” on page 7 - 7).

If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted,;
the module will be off when the computer starts up.

If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.
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Mobile Partner

With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see

/

).

Mobile Partner Application Installation

1.

Enable power to the module by pressing the Fn + [ | key combination (give
the module about 10 seconds to power on and the on-screen icon will indi-
cate the module’s power status).

If a Found New Hardware window appears, click Cancel in all windows
that appear, and then proceed to install the driver as below.

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.Install 3G Driver > Yes.

Choose the language you prefer and click OK.

Click I Agree (button) to accept the license agreement.

Click Next > Install.

Click Finish to restart the computer.

. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile
Partner icon on the desktop.
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Mobile Partner Application

You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

4

Mobile Partner Help

Profile Management

1. Power on the 3.75G/HSPA module using the Fn + [Z] key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop E:3).

3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.

4. Click New [ ®s  and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider. Online Help...

5. Click Save | s to save the profile.

To get help on Mobile
Partner  configuration
and settings, click the
Help menu and select
Online Help or press
F1.

_E!|[:| |

S
[Gomee  Onee e Figure 7 - 39

il = Profile Management
s [ ]

s e I —

Password!

[
=
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Connecting to the Service Provider

1. Power on the 3.75G/HSPA module using the Fn + [Z] key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop i3,

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect [ comext | t0 begin the connection process.

Figure 7 - 40 U - E B
Connect See

F i g ure 7 = 41 Authenticatin
Network @ g

Connection Prompt
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6. When the connection is successful you can move the cursor over the network icon

in the taskbar to display the connection information. Figure 7 - 42
Currently connected to: Connected
.&l ZEccess: Local and Internet TaSkbar
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons and a network icon in the taskbar .

J_i. 0.00 kbps

9. To disconnect click the Disconnect [ giemeat | iCON, OF right click the taskbar icon
and select Disconnect.

Bl Oparabon Tock Hel

Disconnect from Figure 7 = 43

Connect to a network Disconnect

Puokle Wames: |12 @ Turn on activity animation

Turn off notification of new networks

@ Coerection :E Stai ﬂ Tewt ! Phonsbock
[P Mtisiial) ]

Diagnose and repair
Metwork and Sharing Center
RO g YRR YLke

CN|

Tl Hstes ooOoO | 8 {pocones oo

10. The program will disconnect from the service provider.
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11. The module will still be on, and you will need to press the Fn + [Z ] key combination
to turn it off.

12. If you click the Mobile Partner close icon [ a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure 7 - 44 Prompt X

Exit Prompt .
I:el Do you want to teminate cument connection and close Maobile Partner?

0K || Cancal|

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn + [Z ] key combination to turn off
the module (pay careful attention to this aboard aircraft - see “Wireless Device

Operation Aboard Aircraft” on page 7 - 38).
14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted;
the module will be off when the computer starts up.

» If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.

|
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Fingerprint Reader Module

The fingerprint reader module provides a high level of security for your computer. &
Make sure you have administrator’s rights to your computer, and have a Windows Help & Manual
password enabled for full security protection. Right-click the taskbar icon

[A to bring up the menu to

Before beginning the enroliment process it is recommended that you go through the | (. Help.
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >

Protector Suite QL > Fingerprint Tutorial after installing the driver. Insert the Device Drivers &
Utilities + User's Manual

disc and click Option Driv-

Fingerprint Reader Driver Installation ers (button). Click Unlock
. . - , . . (button) and then click 4.In-
1. Insert th_e Device Drivers & Utilities + User’s Manual disc into the CD/ stall FingerPrint Driver 7
DVD drive. >Yes.
2. Click Option Drivers (button). Click Documentation to
3. Click 4.1nstall FingerPrint Driver > Yes. open the folder containing
4. Click Software Installation. e eV I i Gl
S. CI!Ck N_EX_t > Next > Next. To install the Adobe Acrobat
6. Click Finish > Yes to restart the computer. Reader software to read the

file, insert the Device Driv-
ers & Utilities + User's Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).

.|
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\ A/
L&
Fingerprint
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

Figure 7 - 45
Fingerprint
Enrollment

User Enrollment

1. Click Start > Programs/All Programs > Protector Suite > Control Center, or
doubile click the taskbar icon (click Initialize).

2. On the first run of the program you will be asked to click the Accept button to
accept the license.

3. If you have not set a Windows password you will be prompted to do so (note: If
you have not set a password Protector Suite cannot secure access to your
computer).

4. Click Submit when you have entered password.

5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get
help with fingerprint enrollment at any time).

& Frotector Huime AR

Contral Center Home = Manage Fingerprints

Viru are able to use fingesprnt logan and athes sppleations usng your lingerprnt reader.

Envoliment
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6. Click the button above any of the fingers to begin the enroliment process for that

finger. ' ' ] 7£l§

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.

8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then Fingerprint
click Save and Continue. Enroliment

9. Enter a backup password and click Apply. NS (R s S Sy e

10. Close the fingerprint status window. ommended that you enroll

& Frotector Suite 2009 [E=SEETRC more than one finger in
Control Center Home »  Manage Fingerprints »  Status I User: 3-1 I case of injury etc.

I=
o -
Control Center Home Backup password Notset @ | Change e
dentty e
Applications
Settings Weak — > Strong
Help [sesssees Figure 7 46
spply Fingerprint Status
Fingerprint logon Set .| Change
Automatic backup Set @ | Change
Recommendations: ‘
5 55
st Number of enrolled fingers: 3 .| Change |
Application or driver update No information () | Change
With enrolled fingers you can use fingerprint applications:
s & n K
i ] fois

Link an application to a finger and then launch it simply by scanning the finger on the sensor.
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Figure 7 - 47
Control Center &
Biomenu

11. Right-click the taskbar icon E! and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center etc. from the
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.

13. You can also run the Tutorial, or Product Tour video to get more information.

Lefiar
[ | 3-1

[+ Lock computer

”"é Registered Sites

Register...
< E-Wallet
- Lock Personal Safe
e ‘Stmng Password Generator

Control Center...

14. See “Help & Manual” on page 7 - 43 for further details.

15. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, E-Wallet or
Strong Password Generator, open the Control Center and access the Help
menu.

.|
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Application Launcher

The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc.

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant
to dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such
as credit card details, account numbers etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.

.|
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Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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PC Camera Module

N\ AL/
LY Make sure that the PC Camera module is on before installing the driver and use the
S EER ] Fn + F10 key combination (see “Function/Hot Key Indicators™ on page 1 - 13) to
EIET (MHETUETRn toggle power to the PC Camera module. When the PC Camera module is powered
o[- SRR el on, the on-screen indicator will briefly be displayed. Make sure you install the driv-

SERE TR SRR ers in the order indicated in Table 4 - 1, on page 4 - 3.
Manual disc, and any

accompanying insert
pages, for the latest up- - . i S B
dated information on the series. You will have the appropriate application installed for your camera. Make
Sl e Een R EIEAl  sure you access the application via the WebCam desktop shortcut.

which may override the

information provided

here.

There are a number of different camera modules available with this computer model

. |
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PC Camera Driver Installation

- . . - . \ A/
1. Make sure the module is powered on, then insert the Device Drivers & Util- 7@:
ities + User’s Manual disc into the CD/DVD drive. PC Camera Screen

2. Click Option Drivers (button). Refresh

3. Click 5.Install Camera Driver > Yes. ¢ v ol e

4. Choose the language you prefer and click Next > Next. Scré’en refresh rate is

5. Click Finish to restart the computer. subject to lag or stutter-

6. Run the BisonCap application program from the BisonCam shortcut on the ing, then reduce the
desktop, or from the BisonCam item in the Start > Programs/All Pro- window size, or adjust

grams menu (if the hardware is turned off use the Fn + F10 key combina- i SEEEEEE U los

tion to turn it on again). ;‘;'r?r Space Compres-

To reduce Output Size
and/or Color Space
Compression run the
BisonCap application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Double-click Sound 2 (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is
not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.

7. Click OK and close the control panels.

8. Runthe BisonCap application program from the Start > Programs/All Programs
> BisonCam menu.

9. Go to the Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).
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Configure Speech Recognition...
Disable

Show Disabled Devices

v Show Disconnected Devices

Properties

Right-click
_setDefaut

: " Microphane Properties - =)
Playback | Recording | Sounds o iR 5 =
. . —" General | Levels | Enhancements | Advanced
Select a recording device below to modify its settings:
- Microphone Micraphone
Realtek High Definition Audio —_—
G working I O 1o [ Batance |

Microphone Boost

H { =200d8

EDE'-"ECE Options  Capture  Zoom

Capture | Zoom  Help

v BisonCam, NB Pro

v Microphone (Realtek High Defini

Start Capture

Stop Capture

v Capture Audio

Set Time Limit...

[ Devices | Options  Capture  Help

v BisonCam, NB Pro

v Microphone (Realtek High Defini

Capture ] Help
Start Capture

Stop Capture

v  Capture Audio
Set Time Limit...

Modules & Options

Figure 7 - 48
Audio Setup for PC
Camera
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BisonCap
4 BisonCap is a video viewer for general purpose video viewing and testing, and for

_ _ capturing video files to .avi format.
Pre-Allocating File

Space 1. Runthe BisonCap program from the Start > Programs/All Programs > Bison-
You may pre-allocate the Cam menu (it is recommended that you set the capture file before the capture
file size (File > Allocate process - see Set Capture File below).
File Space) for the cap- 2. Goto the Capture menu heading (if you wish to capture audio check “PC Camera
ture file in the BisonCap Audio Setup” on page 7 - 50) and select Start Capture.
RIGSHETE 3. Click OK (the file location will be displayed in the pop-up box) to start capturing the

Pre-allocating space on video, and press Esc to stop the capture (you can view the file using the Windows

the hard disk can improve Media Player).

the capture quality (par-

ticularly of large capture Set Capture File

files), by reducing the £ prinr to capturing video files you may select the Set Capture File... option in the
amount of work the hard . . . . . .

disk has to do in finding | 1€ menu, and set the file name and location before capture (this will help avoid ac-
space for the video data | cidentally overwriting files). Set the name and location then click Open, then set the
as it is being captured. “Capture file size:” and click OK. You can then start the capture process as above.
see aiso "Reducing Vid- § - o6 the important information in “Reducing Video File Size” on page 7 - 53 in
eo File Size” on page 7 -

53. order to save file space, and help prevent system problems.
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 52), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 7 - 52) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Runthe BisonCap program.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

. |
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Figure 7 - 49
Video Capture Filter

Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Runthe BisonCap program.
2. Goto Options and scroll down to select Video Capture Filter....

3. Click either 50Hz or 60Hz under Frequency/Powerline Frequency.
Froperties S | Prepertier ===

Poaperty Page: | Wideo Proc Amp | Camens Contmi | Procerty Page | Nideo Frec hep.

F Ao Whie eince et gan 7] Auaa Wit Bance. FGE gan
Envronment Ll | i | Errmorment
& g Tungmen

Daigit R
Fotmon
Venseresl Visiesl

I Low Ligt Mode

A
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Zoom
The BisonCap program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Runthe BisonCap program.
2. Goto Zoom and select Zoom Out/Zoom In.

IIu-um Help Figure 7 - 50

P Zoom/Setting
ZoomIn ﬁ
) L Snapshot Folder
Taking Still Pictures
The BisonCap program allows you to take still pictures. The Snapshot folder's
default location is on the
1. Runthe BisonCap program. desktop. Do not move
2. Go to Options and select Take Picture. this folder or an error
3. The picture (in JPEG format) will be placed in the Snapshot folder ﬁ on the 1Y EPEeEl TEn Ml
s try to take a still picture.

desktop.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

PC Camera Module 7 - 55



Modules & Options

7 - 56



Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

N A
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).

8 - 4 Viruses
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Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more

system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator m is | Low Battery. Plug in the power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using
an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Energy Star Power Saving” on page 3 - 10).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn
off/remove the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 16). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8/).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix B for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
I

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 13) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

If the LED is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1-9).
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Problem

Possible Cause - Solution

work.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3.5G
modules cannot be detected.

The modules are off. Check the LED indicator 4" and/or function key indicator
to see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn + ] (3.75G) key combination(s) in order
to enable the modules (see “Function/Hot Key Indicators” on page 1 - 13).
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Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on pagel - 13). Run the
BisonCap program to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

A file cannot be copied to/from a
connected Bluetooth device.
The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

Problems and Possible Solutions 8 - 11




Troubleshooting

Screen Resolution Error

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

O@v | » Comtrol Paned

Calor

Indsing  Iotemet  SCHInitator  Keyboard se  Networkand  NVIDIA
Options  Options Sharing Ce.  Contr..

PE/ Yy S

Offime Files  Parerdal Penand  Prople New Peformance Perensks..  Phore n
Controls  Input Devices Me Informatio.. Modem .

LU L1 Fa N LS

Figure 8 - 1 - Control Panel System and Maintenance
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3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

T et =]

File Action View Help

2 i Name Status  Triggers Next Run Time  Last Run Time Last Run Result Autho| |Actions
7% Task Scheduler Library : ‘ e N
2 B Wikt @ Hotstart Ready  Atlog on of any user 1/9/2007 532:21 PM _ The operation completed successfully, (0:0) Micro
= Windows Running At log on of any user PB The task is currently minning, (x41301) I | B Creste Basic Task..

% Create Task...

> Import Task...

[ Display All Running Tasks

| CertificateServicesClient
7 Customer Experience Improv
71 Defrag

1 DiskDiagnostic Properties 9 NewFolder..
. - Delete X Delete Folder
1 Multimedia |6 Refresh

= gl i | ;
] NetworkAccessProtection

@ Hel
General | Triggers | Actions | Conditiens | Settings | History | LB

< RAC Selected ltem -
J RemoteAssistance Name: TMM B Run
1 shel Author: Microsoft Corporation a End
1 SideShow
™ SyncCenter Description: Microsoft Transient Multi-Monitor Manager ¥ Disable
1 SystemRestore Export...
L Tepip
| TextServicesFramework B ipmrens
= Delets
. Security options X Delete
= wot Help
(] Windows Error Reporting When running the task, use the following user account:
I WisdausCaleridar Authenticated Users
1 Wired
=1 Wireless Run only when user is logged on

| Windows Defender )
Run whether user is logged on or not

Do not store password. The task will only have access to local resources

| Run with highest privileges

Figure 8 - 2 - TMM Disable
6. Close all the control panels.
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Item Description
Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
D slot and it will appear as a removable device.
DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or

Port simultaneous display on the LCD and external monitor/FPD.
e-SATA Port Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
e-SATA Attachment) port.
HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
HDMI transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or

Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio (see “HDMI Audio Configuration” on page B - 6) and video signals.
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Item

Description

Headphone-Out Jack

¢

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack

A

4

Plug an external microphone in to this jack to record on your computer.

RJ-45 LAN Jack

an

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot

oK X,

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack

I+

This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports

<>

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

A - 2 Interface (Ports & Jacks)
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Appendix B: ATl Video Driver Controls (Win Vista)

The basic settings for configuring the LCD are outlined in “Video Features” on
page 1-17.

For Information on video in Windows 7 see “Video Features” on page D - 7.

ATI Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers

(button).

1. Click 2.Install Video Driver > Yes.

2. Click Next > Install (button).

3. Click the Express (or Custom if you prefer to manually configure the
driver installation settings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish > Yes to restart the computer.

Note: After installing the video driver go to the Display Settings control panel to
adjust the video settings to the highest resolution (see “Video Features” on page 1
- 19).

ATI Video Driver Installation B - 1
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Video Card
Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
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ATI Catalyst® Control Center

Adjust the video settings from the ATI Catalyst® Control Center.

4

ATI Taskbar Icon

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon Eidl in the taskbar
(or by right-clicking the icon
and selecting Catalyst
Control Center).

If you don’t see the ATl icon
in the taskbar, click Prefer-
ences (tab) in the ATI Cat-
alyst® Control Center,
and select Enable System
Tray Menu.

Right-click the AT! icon i
to bring up the taskbar
menu.

FigureB-1
ATI Catalyst Control
Center Basic Settings

Open the Display Settings (see page 1 - 17) control panel.

Click Advanced Settings (button).

Click Catalyst(R) Control Center (tab) and then click ATl Catalyst Control
Center (button) to start the control center.

Select either Basic or Advanced and then click Next.

If you have selected Basic a wizard will help you set up the display options, or if
you have selected Advanced you will be taken to the ATI Catalyst Control
Center (you can change the options from the Basic menu or the View menu in the
ATI Catalyst Control Center).

1 catae conva oo N ==

ATI Catalyst
Control Center™

Welcome to the ATI Catalyst® Conirel Center Note that the control pane|s

pictured in the following pages
~ are from the Advanced set-
tings.

What would you like to use?

L}

" Basic [Easy Setup Wizards and Quick Settings]

Provides both step-by-step assistance and Qui
display setup, and other common tasks,

ings for changing your

[~ Dont show this page again

You can choose between "Basic” [Easy and Quick] or "Advanced" at any
time

Click Next to continue

Extt Next > |
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The ATI Catalyst® Control Center provides additional video configuration con-
trols and tools which allow quick access to features such as display options, 3D Set-
tings, color and Help menus etc. Adjust settings from the options in the Graphics

Settings Tree View pane.
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4

Help Menus

Click Help (tab) and se-
lect an option from the
drop down menu. Press
F1 to bring up Help for
any currently selected
page.

Figure B - 2
ATI Catalyst Control
Center Advanced
Settings

ATI Catalyst® Control Center B - 3
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Attaching Other Displays

“ Configuring an External Display in Windows Vista
Display Devices 1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Beside the  built-in . i . .
odes ur Windows Mobility Center control panel (Mobile PC > Adjust commonly used

LCD, you can also use

an external monitor/flat mobility settings) and click Connect display.

panel display as your 3. Click on any of the buttons to configure the displays to your preferences, or click
display device. The fol- Display Settings (in the New Display Detected window) to access the control
lowing are the display

options:

() o P Dy ot

Choxrie the appearsnce of your displey

y 7 . | [lg "] Displa
Lo te
. V = iﬁ Iﬁ
Brightness olume i 2 -

Mo sync @ D drbtep e 8 s o)
partnerships @igp Mot presenting B et s 4 ey bt P sl (e

The built-in LCD.

An external monitor
connected to the
external monitor port.
A flat panel display
connected to the
external monitor port.

Shaw oy it o The exteral dples gy

[ syncsetings | | | Tumon

Sync Center Presentation Settings

\ A/

7. \Y
Figure B -3 Switching Displays Using Fn + F7
New Display If your external display is connected to the HDMI port, and you are using the Fn + F7 Hot Key combi-
Detected nation to switch displays; note that the audio will not automatically switch back to/from the HDMI con-

nection and will need to be manually switched. See
for details.
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Configuring an External Display using the ATI Catalyst Control Center
Alternatively you can use the ATI Catalyst Control Center to configure any at-
tached displays.

agrOdE

N o

Attach your external display to the external monitor port/HDMI-Out port and turn it on.
Go to ATI Catalyst Control Center (see “ATI Catalyst® Control Center” on page B - 2).
Select Displays Manager from the Graphics Settings Tree View pane.

Attached displays will appear in the Desktop and Display Setup box.

Right-click, the attached display icon to bring up the Display Mode options (see
“HDMI Audio Configuration” on page B - 6).

Select an option from the menu, and click Yes to accept the settings.

Click OK to save the changes.

I Catabput™ Eonticl Conter =T
= View = o Hotheys = 4 Profiles » o Profermnces « (g Hilp =

At isiben,y | Right-click the attached

- display icon and select an
option (Clone or Extend)
from the menu.

Rtate
Estend Mun rto monites

Swap diapley mapping

" - Salacted Dunplay o AT) Mobity Rackeon HD 4500 Saes
[ L5 = Serpes Toch, [Clerm |

Deshzca wea Calor qusty Pereah ate
[2axma =] [Wonmaes =] [ -l
Ratsion

[Frdmtimdmn s =] o

[ w | | | |
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Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

Configure the Display
Detection Option from
Display Options in the
Graphics Settings
Tree View pane. You
can configure the Cata-
lyst® Control Center
to manually or automati-
cally detect attached
displays.

FigureB-4
Displays Manager



ATI Video Driver Controls (Win Vista)

HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals
and you will can configure the audio output as per the instructions below when an
HDMI enabled device is connected to the HDMI-Out port.

Windows Audio Setup for HDMI

Connect a device with HDMI support to the HDMI-Out port.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound » (Hardware and Sound).

Click Playback (tab), and click to select Digital Output Device (HDMI).
Double-click Digital Output Device (HDMI) (or right-click the icon and select
Properties).

agpdE

Flgure B - 5 Playback |Recording | Sounds |
HDMI DeVice Select a playback device below to modify its settings:
eal utpu
ATLHI Audio
%

Click the taskbar volume in-
dicator ﬂ when HDMI De-
vice is selected, and you will
note that the icon at the top of
T the volume level indicator
— has changed.
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6. Adjust the HDMI settings from the control panel tabs.

7.

W Fealbek HOMI Output Propertes ' ﬁ

I| Gererdl | Supoorted Pormats | Levels | Erancements | advanced|

fricates HOMI Outpu]
‘ .] [ change pon. |

'I Canaralier Informatinn

!“: ATIHDME Audio b_vw'!-n__

Aach Eformation
LR @ HOME Begital lack

Click OK to close the Sound @ control panel.

| Gemeral | Spported Formats | Levels | Enhancements | Advanced |

Entoced formats

Which of the following formats I5 your Digital Receer able to
ecoce’

[ o7 Audic [

|”! Doty pigitat

1] Macrotedt WA Pro Audic

Sample flabes

VWTath o1 Ehe folliwing Lampie saled are upported by pous
Digetal Recerert

[0 [

Seiect the sound effects i acoly for your cument istening
cenfguration. Changes may not take effect Lntl the next Bme you start
Plahack.

Disabie ol sound effects frerrehate roeie

Vxce Cancelazon s
Pitch Shift
Gaahoer
Sourd [ffect Propertes
Prowder | Reshiek

Descrpson 1 Seulates multple playback evnvronments.

Gerersh | Suponted Formats | Levels | Eriuncaments | Adverced

Detan Pormat

Select the ;ampie rate and bit depth to be used when runaing
i shared mode.

Extiusve Mode

¥ dligw applications to take exchusive control of this device

| Gine exchriive mode apphotions priosity

16 bit, 9000 He VD Quabin BT

Figure B - 6
HDMI Device
Properties
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‘ HDMI Notes
e .~ + Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
Other Applications ing to play audio/video sources through the device.

If you are using a third HDMI Video Configuration

party application  to 1. Connect an HDMI cable from the HDMI-Out port to your external display.
play DVDs etc. from 2
any attached DVD de- ’

vice, you will need to

Configure your external display as per the instructions in “Configuring an
External Display using the ATI Catalyst Control Center” on page B - 5.
consult the applica- 3. Set up your external display (TV or LCD) for HDMI input (see your display device

tion’s documentation manual). . _ _
to see the appropriate 4. You can now play video/audio sources through your external display.

audio configuration
(the application must
support digital to ana-
log translation).
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ATI Video Driver Controls (Win Vista)

Display Modes

Single
Only one of your displays is used.

Clone Mode

Clone Mode simply shows an exact copy of the Main display desktop on the other
display(s). This mode will drive multiple displays with exactly the same content, res-
olution, refresh rates and color quality etc.

Extended Mode

Extended Mode treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When Extended Mode is enabled,
you can drag any icons or windows across to the other display desktop. It is therefore
possible to have one program visible in one of the displays, and a different program
visible in the other display.

\ A/
2 &
Switching Displays Using Fn + F7
If your external display is connected to the HDMI port, and you are using the Fn + F7 Hot
Key combination to switch displays; note that the audio will not automatically switch back

to/from the HDMI connection and will need to be manually switched. See
for details.

4

Function Keys

You can use the Fn + F7
key combination to tog-
gle through the display
options:

¢ Notebook Only

¢ External Display Only

* Notebook + External
Display

Give the displays
enough time to refresh.

Swap Display
Mapping

If you wish to switch the
Main and Clone dis-
plays, right-click either
the Main or Clone icon
(Displays Manager),
and then click Swap
Display Mapping.

Display Modes B - 9
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4

Selecting Display
Modes

Right-click the at-

tached display icon
H&S W and select an
option (Clone or Ex-
tend) from the menu.

Figure B -7
Displays Manager
Clone Mode

Clone Mode

Clone Mode simply shows an exact copy of the Main display desktop on the other
display(s). This mode will drive multiple displays with the same content. Use this
feature to display the screen through a projector for a presentation.

Eo = = e o s Ci =ToEs
3 View - W Hotkeys - Profiles - §ff Preferences - @ Help - o View = Wb Hotkeys + 4 Profiles « ff Preferences = (g Help +

Displays Properties ) E . i :__ Displays Properties

i’:ﬂm"‘m’w ke Adugher
) T.AT) Moty Radesn HD 4500 Seees | Defaut LCD « Sampe Tech | =l 'M‘:‘m"' o [ A1 Mokt Flaciner WD) 4500 Savme | Dot LCD) | -
Desbop and Dulay Senp 4 W Hotebook Panel Frops |~ Deshic arad Display Sehss
% & 30
| ! |-l | &) forve™ Video -
!_| | - Clare Main with muritor

Aeached deplays cumently dsabied

To make changes, drog o aght clek the daplay
went

" Selacted Dy on AT] Mabity Raeon: HI 4500 Senes
[ Dot LD » Sarmpa Tach. [Cone |

Detect Duplayy

e e ety danbied
% RomATick ety Dot Dy
v

Dimpiay o ATI Mabiry Fiaieon MDD 4500 Senes
Defat LCD [ Sngle |

Deskacp swn Cobor qusiey Pefreah e Doddopaws  Cobor qualty Relresh e
[atame =] [ e ] [ - [ezexTea ] [Vgh ozen) ] [some =l
Fotson Futation:
|ETe—— = Liriie [Gonderd Lancecace 111 ~] Force

x| | J | v | / = | | | |

Click Monitor Properties to make adjust- Drag any attached display here to disable it,
ments for any attached displays. and simply drag it back to the Clone window
to re-enable it.
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Extended Mode

In Extended Mode each monitor can be configured separately with the Windows 4
desktop stretched between the two monitors (except the taskbar). This configuration Selecting Display
is recommended if you are using two monitors of different size, as you may config- Modes
ure the best resolution, refresh rates and color quality for each display. Sk (e e
mCataiyst"‘.ContmIC.enlef E‘ﬁ'@ taChed dlsplay ICOﬂ
i View ~ 4 Hotkeys « 4 Profiles -~ & Preferences « @ Help - Click either the Graphics &/=/™ and select an
i et | Adapter pop-up menu, or :)ptlgnf (Clotﬂe B
W L SRS e | | clickthe icon for the appropri- end) from the menu.

ate display. Extended Mode

=) 8 Dispbays Mariager Graphics Adapter

= Displays Properties

¥4 Display Options [TAT! Mobity Fadeon HD 4600 Seris [ Defeul [C0] <l =1
8 Moritor Properties 1 1ATI Mobilty Radeon HD 4500 Series | Default LCD . .
! Motebook Panel Proper ZATHadeDmSmISmn T"‘d"l_ Conflgure the SettlngS from When enabled, you

2. ocktop . -
© cor i the Selected Display.... can drag any icons or
B = menu. windows across to the
e other display desktop.
It is therefore possible
To make changes, drag or right-click the display to have one program

i o G ATI Mobitty Radean HD 4500 5er — visible in one of the

| Defautt LCD [ Extended | diSplayS, and a differ-
Desktoparsa  Col Refresh ate ent program visible in
Enbean | [oz4x782 - 224it) EIEES |

Retation the other display.

PREMIUM
GRAPHICS | Stendard Landscape (07) | it

Basic K | soply Dicad | Deais | Flgure B-8
Displays Manager
Extended Mode
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Using New Display Detected to Enable Extended Mode

4 \ 1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
i ) 2. If a New Display Detected window does not appear in Windows Vista, go to the
Display Settings Windows Mobility Center control panel (Mobile PC > Adjust commonly used
Extended Desktop mobility settings) and click Connect display.
Use the control panel to 3. Click to select Show different parts of my desktop on each display (extended).
drag the monitors to 4. Click Right or Left under Extend your desktop.
match the physical ar- | 5. Click Apply > OK.

rangement you wish to e

use.
! New Display Detected
5 ey

You can drag any icons
or windows across to ei- Choose the appearance of your display

ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Extend your desktop:
@ Right

© Left

@ Show different parts of my desktop on each display (xtended);

() Show my desktop on the external display only

Figu re B _ 9 To select different settings, go to Display Settings in Control Panel,
. [ Turn on Presentation Settings
New Display
DeteCted |l [ Apply _] [ oK I [ Cancel
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Using Display Settings to Enable Extended Mode

1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.

2. Open Display Settings (see “Video Features” on page 1 - 17) control panel.

3. Click the monitor icon (e.g. B), and make sure you have checked “Extend the

desktop onto this monitor” and click Apply.

S Display Settings

| Maritor |

==

Drag the icons to match your menitors,

‘ Identify Monitors |

2. Generic PnP Monitor on ATI Maobility Radeon HD 4500 Series . |

|¥] Extend the desktop ento this monitor

Resolution:

Low [ High
1024 by 768 pixels

How do I get the best dicplay?

Colors:

|Highest @2bit) = |

| Advanced Settings... |

OK

| | Cancel

Click the appropriate monitor icon
(e.g. B) to be able to select the op-
tion to extend the desktop on to it.

ﬁthis example the Primary Dis-

play @ is on the left, the Secondary
Display B is on the right.

4

Display Settings
Extended Desktop

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 10
Display Settings
(Extend the
Desktop)
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Figure B - 11
Theater Mode

B - 14 Theater Mode

Theater Mode

Theater Mode enables you to display video playback in full screen on a secondary
monitor. Theater Mode can be configured from the Avivo™ Video > Theater Mode

tab in the Graphics Settings Tree View pane.

i Catalyst™ Control Center

Graphics Settings ]

= ﬁ Displays Manager
Displays Propert|
E Display Options
|_';_ Monitor Properties 1
B Motebook Panel Prg
30 =
& Color T
B ) Avivo™ Video
Fresats
Basic Color
Advanced Color
Basic Quality
B e o
All Settings
A PowerPlay™ [T
4 . | 3

PREMIUM
GRAPHICS

Welcome !__:_
& Information Center [

=i View ~ W@ Hotkeys ~ 4 Profiles ~ & Preferences + (@ Help ~

Graphics Adapter

Theater Mode

=l ==

]T AT! Mobility Radeon HD 4500 Series [ Default LCD ]

— Extended Desktop Mode

|
" To select another mode, click

Main Display

Select Theater Mode overay

~ Theater Mode Settings
Set the video aspect ratio to:
* Match the source video

@ You are cumently in Bxtended Desktop Made.

Displays Manager

u.--
—

Second Display

in Standard Mode

" Scale to full screen

|

‘d |

Basic...

Defaults
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PowerPlay ™

PowerPlay™ in the Graphics Settings Tree View pane allows you to set your
graphics processor settings for higher performance or longer battery life.

Zi0 Catalyst™ Control Center [o] @ |
=8 View - \gh Hotkeys ~ 4 Profiles - a Preferences -~ 0 Help -
- (Graphics Settings ]
Welcome
ﬁ Information Center
! Displays Manager Graphice Adapter:
Display Options — .
| B Notebook Panel Proper | 1AT! Mabilty Recsan HD 4500 Seres [ Defaut LCD | |
! 3D PowerPlay™ Settings 1 .
&' E"!‘” - Battery Level: 100% Flgure B-12
£ wiva™ Vidso 5
* Active Vista Power Plan: Balanced POWer PI ay™
Power Source: s‘ Plugged In
Use PowerPlay™ to adjust your graphics processor settings for higher
performance or longer battery life.
¥ Enable PowerPlay™
F] i | 3 |
B., Plugged In: ]Mamrruze Performance __‘J |
= " ' Battery: ]Mammlze Battery Life _vj
RADEON
PREMIUM
GRAPHICS
Basic... oK Apply Defaults
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Appendix C: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-820QM Processor:
1.73GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache &

FSB 1333MHz - TDP 45W
rPGA988A Package

Intel® Core i7-720QM Processor:
1.6GHz

45nm (45 Nanometer) Process
Technology, 6M L3 Cache &

FSB 1333MHz - TDP 45W
rPGA988A Package

Intel® Core i7-620M Processor:
2.66GHz

32nm (32 Nanometer) Process
Technology, 4M L3 Cache &

FSB 1066MHz - TDP 35W
rPGA988A Package

Intel® Core i5-540M / i5-520M Processor:
2.53GHz / 2.40GHz

32nm (32 Nanometer) Process
Technology, 3M L3 Cache &

FSB 1066MHz - TDP 35W

rPGA988A Package

Intel® Core i5-430M Processor:
2.27GHz

32nm (32 Nanometer) Process
Technology, 3M L3 Cache &
FSB 1066MHz - TDP 35W
rPGA988A Package

Intel® Core i5-350M / i5-330M Processor:
2.27GHz / 2.13GHz

32nm (32 Nanometer) Process
Technology, 3M L3 Cache &

FSB 1066MHz - TDP 35W

rPGA988A Package

Intel® HM55 Chipset

Model A Computers:
17" WXGA(1440 * 900) / WUXGA (1920 *
1200) TFT LCD

Model B Computers:

15.6" HD 16:9 Wide Screen (1366 * 768)
/ HD+(1600 * 900) / FHD (1920 * 1080)
TFT LCD

Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM Sockets
Supporting DDRIIl (DDR3) 1066/1333MHz
Memory Expandable up to 4GB

(1GB / 2GB DDRIIl (DDR3) Modules)

ATI Mobility Radeon HD 4570 Discrete
Graphics On Board (PCle 2.0 * 8)
512MB GDDR2 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP
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One 32Mb SPI Flash ROM Embedded 7-in-1 Card Reader (MS/ MS Built-In 56K MDC Modem V.90 & V.92
Phoenix™ BIOS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Compliant
Duo) Note: MS Duo/ Mini SD/ RS MMC Built-In Gigabit Ethernet LAN

Cards require a PC adapter Intel® WiFi Link Module 5300 3*3 802.11

Device (CD/DVD) Type Drive (see Option) N ]
“Factory Options” on page C - 5) Three USB 2.0 Ports Intel® Advanced N WiFi Link 6200 erelgs§
§ One eSATA Port (Supported in Windows LAN Module 802.11 a/g/n 612AN Half Mini-
Easy Changeable 2.5" 9.5 mm (h) SATA Vista/Windows 7 Only) Card with PCle Interface (Factory Option)
(Serial) HDD One HDMI Out Port Intel® Ultimate N WiFi Link 6300 Wireless
One External Monitor Port LAN Module 802.11 a/g/n 633AN Half Mini-

One Headphone-Out Jack Card with PCle Interface (Factory Option)
Intel® High Definition Audio Compliant One Microphone-In Jack 3rd Party 802.11b/g HMC Wireless Lan
Interface One S/PDIF-Out Jack Module with PCle Interface (Factory

3D Stereo Enhanced Sound System One RJ-11 Jack Option)

S/PDIF Digital Output One RJ-45 LAN Jack 3rd Party _802.11b/g/n HMC Wireless Lan
Built-In Microphone One DC-In Jack Moqule with PCle Interface (Factory

2 * Built-In Speakers 1W, 8Q Option)

. . One ExpressCard/34/54 Slot
Full Size WinKey Keyboard Two Mini-Card Slots (USB/PCle):

Bulln TouchPad (htegrated scrolling key | Siot 1 for WLAN Module with HMC Slot
unctionality) wi ulti Sesture Function and PCle Interface (Factory Option)

U‘rge Instant Keys (WWW, E-Mail, Silent | | g4 5 o 375G Mini-Card Slot with USB
ode) Interface (Factory Option)
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Specifications

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module (Factory Option)

2.0M Pixel USB PC Camera Module
(Factory Option)

UMTS/HSPDA-based 3.75G Module with
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America.

Supports Wake on LAN
Supports Wake on USB
Supports Resume From Modem Ring

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 19V, 4.74A (90 Watts)

6 Cell Smart Lithium-lon Battery Pack,
48.84WH / 4400mAH

9 Cell Smart Lithium-lon Battery Pack,
73.26WH, 7200mAH (Factory Option)

Security (Kensington® Type) Lock Slot
BIOS Password

Fingerprint Reader Module (Factory
Option)

Windows® Vista (with Service Pack 2)
Windows® 7

Temperature

Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

Model A Computers:
397.2mm (w) * 282.5mm (d) * 39.5mm (h)
2.9 kg With 6 Cell Battery & ODD

Model B Computers:
374mm (w) * 256mm (d) * 37.9mm (h)
2.5 kg With 6 Cell Battery & ODD
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Super Multi Drive Module

Blu-Ray Combo and Blu-Ray Writer
Module

Intel® WiFi Link 5300 WLAN Module
Intel® Advanced N WiFi Link 6200 HMC
WLAN Module

Intel® Ultimate N WiFi Link 6300 HMC
WLAN Module

802.11b/g HMC WLAN Module
802.11b/g/n HMC WLAN Module
Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module

2.0M Pixel USB PC Camera Module

9 Cell Smart Lithium-lon Battery Pack,
73.26WH

Fingerprint Reader Module
UMTS/HSPDA-based 3.75G Module with
USB Mini-Card Interface

Specifications
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Windows 7 Information

Appendix D: Windows 7 Information

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 7 OS where there are significant differences from Windows Vista, or where is it helpful to have
essential information or features repeated. For items not specifically covered here see the remainder of the man-
ual for information.




Windows 7 Information

Model Differences

This notebook series includes two different model types. The models differ as indicated in the table below however
all other features, modules and specifications are identical (see Appendix D).

Feature Model A Model B
Byl Tee 17" WXGA(1440 * 900) / 15.6"HD 16|;9D\J’rv'(‘i‘gosociegeé‘0§1/366 768)/
Supported WUXGA (1920 * 1200) TET LCD

FHD (1920 * 1080) TFT LCD

Design

[l e

O S [ TS T i T8 T 108 O
' A e e M e e e JEJE R 1'[1‘
S el T SO 5, T8
ol | o) | o | 5
= A N e e
(O | O T e

[l

Table D - 1 - Model Differences
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DVD Regional Codes

4

Changing DVD Regional Codes

Windows 7 Information

Go to the Control Panel and double-click Device Manager (System and Security > System), then click the + next to DVD/CD-ROM

drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

Region Geographical Location
1 USA, Canada
2 Western Europe, Japan, South Africa, Middle East & Egypt
3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong
a South & Central America, Mexico, Australia,
New Zealand
5 N Korea, Russia, Eastern Europe, India & Most of Africa
6 China

Table D - 1 - DVD Region Codes

General | DVD Rngion | Valumes | Diivet | Dataits

Mest DVDs ase encodad ior play in specte regions. To play & regionalzed
DVD en your computar, you must satyour CVD drve to play discs from that
ragion by selacting 3 gecgraphic area oe the folowing kst

CAUTION You can change the region 5 imited rumbar of imes.
Adtar Changas . zam, changs th reg Fyou
rairatal Windows o move your DVD drive 1o & &ferort compuser

Changes remaining: &

Te change te cumant ragion. salect 8 geographic ares. and hen click 0K

Adghanistan -
Albania

Algedia =
Amencan Samoa

Andona

Angala

Angulla

Currert Flegion  [Not Selected

Mew Ragion [

[ ox | cancet

DVD Regional Codes D - 3
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Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon [, and then select Properties if you want to customize the appearance of the Start menu.

[
R [T
d LT

Stid 4 o .

A i @ £

L e Y o e
t.. piliEok E P g"

B o & - <

iy
o

Click here to t.bgélé .Céte_éo,ry.Vi.ew

o Canenl

Properties - ' . B Wk Mt
BRI R o Figure D - 1 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

D - 4 Windows 7 Start Menu & Control Panel



Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Windows 7 Information

Fn Keys

Function

Fn Keys Function

Fn+~

Play/Pause (in Audio/Video Programs)

Fn + F5/F6 Volume Decrease/Increase OQ
et dl

Fn+_[j

3.75G Module Power
Toggle*

Display Toggle. See “Switching Displays Using Fn + F7”

Fn+F7 on page B - 4

gD, e¥ed,

Fn + F8/E9 Brlghtr:ess Decrease/ QQ
ncrease g /

Fn+F1 Touchpad Toggle m (Grr, )
Fl g i
Turn LCD Backlight Off PC Camera Power = - -

Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F10 Toggle @m < f
4 | E——
WLAN Module Power =¥ =

Fn+F3 Mute Toggle Fn+ F11 N, lioFe
Toggle / " /
Fn + F4 Sleep Toggle Fn + F12 BIuetoothToMgc;cfgle Power m m
i f

*Silent Mode Toggle

o ao

*When enabled, Silent Mode will reduce fan noise and save power
consumption. Note this may reduce computer performance.

Table D - 2 - Function & Hot Key Indicators
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Hot Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle
the Silent Mode on/off with one quick button press. Note that in Windows 7 the E-Mail button will only function
after the Outlook or Outlook Express applications are installed (these applications are not installed by default in

Windows 7).

Hot Key Function

Activate the Default E-Mail Browser

Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

SISIY

D - 6 Function/Hot Key Indicators



Windows 7 Information

Video Features

You can configure display options from the Display control panel in Windows, and from the AT Catalyst Con-
trol Center as long as the appropriate video driver is installed.

EL  Catalyst(TM) Control Center

View >

To access Display (Control Panel) and Screen Resolution in Windows: Sort by .
1. Click Start and click Control Panel. Bl

2. Click Display (icon) - In the Appearances and Personalization category. e

3. Click Adjust Screen Resolution/Adjust resolution. Hew -
OR B Screen resolution

4. Alternatively you can right-click the desktop and select Screen resolution (see right). =i

5. Use the dropbox to select the screen Resolution @ (Figure D - 2 on page D - 8). =

6. Click Advanced settings @ (Figure D - 2 on page D - 8) to bring up the

Paste shortcut

Advanced properties tabs. il’:
To access the ATI Catalyst Control Center: Switching Displays
1. Click Start and click All Programs (or just click Start and select ATI CCC @ in ATI Video for
Figure D - 2 on page D - 8). Windows 7

2. Click Catalyst Control Center.
3. Click ATI CCC (Advanced/Wizard) e (Figure D - 2 on page D - 8). combination, Fn + F7
OR - key combination or
4. Double-click the taskbar icon % @ (Figure D - 2 on page D - 8 - note that you may BSE SR E e e e
need click the show hidden icons button in the taskbar in order to see the ATI R uigeleEipl=lRieliiielg e =L
taskbar icon ). plays for ATl video in
OR Windows 7.

5. Right-click the desktop and select Catalyst(TM) Control Center.

Use the FF] + P key

Video Features D - 7



Windows 7 Information

Screen Resolution

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as

your display device.

B » Control Panel » All Control Panel ltems » Display » Screen Resolution

b b

Search Cantral Punel

o

Change the appearance of your display

Display: |1 Mobile PC Display = |
Resolution: 092{] x 1200 (recommended)  ~

Qrientation: Landscape =

Connect to a projector (or press the L] key and tap P)

and other items larger or smaller

What display settings should | choose?

OK

Detegt
Identify

f\dvanciE' settings

. Cancel

(@ Default Programs

[ Desktop Gadget Gallery
& Internet Explorer (64-bit)
& Internet Explorer
& Windows DVD Maker
£ Windows Fax and Scan
@ Windows Media Center
|3 Windows Media Player
] Windows Update

A, XPS Viewer

| Accessories

| Catalyst Control Center

E@ll CCC - Advanced
Bl CCC - Wizard
|nfdda
E Help
EQl Restart Runtime
| Games
| HSPA modem
.. IMicron

1 Back

[ Search programs and fites

Documents

Pictures

Music

Games

Computer

Control Panel

Devices and Printers

Default Programs

Help and Support

cc-was (@)

P Al Programs

2 BB

Figure D - 2 - Screen Resolution & ATI Controls
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Attaching Other Displays

Configuring an External Display in Windows 7

Attach your external display to the external monitor port/HDMI-Out port and turn it on.
Go to the Screen resolution control panel.

Click the Detect button.

pPobE

k 1
K9_)=[B <« Display » Screen Resoluon
—

+ [ 44 ||| Search Centrol Panet

The computer will then detect any attached displays.

Change the appearance of your display

Multiple displays:

This is currently your main display.

Resolution:

Orientation:

Connect te 2 projecter (or press the &Y key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

Advanced settings

Attaching Other Displays D - 9

Figure D - 3 - Screen Resolution - Multiple Displays

4

Video Options

Note that card types, specifi-
cations and drivers are sub-
ject to continual updates and
changes. Check with your
service center for the latest
details on video cards sup-
ported.

Windows 7 Information

Switching Displays
in ATI Video for
Windows 7

Use the + P key
combination, Fn + F7
key  combination or
Screen Resolution con-
trol panel to switch dis-
plays for ATI video in
Windows 7.
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5. You can configure the displays from the Multiple Displays menu.

@Qvﬁ « Display b Screen Resolution ~ [ 42 ||| Search Control Pane!

2|

Change the appearance of your display

Display: 1|2. Multiple Monitors =

Resolution: 1024768
Orientation: Landscape -

Multiple displays: ffuplicate these displays

Duplicate these displays

This is currentlylyo Etend these displays Advanced settings
Show desktop only onl

Connect to a projecgoW desktop only on2_/4ap p)

Make text and other items larger or smaller

T

D

What display settings should I choose?

Figure D - 4 - Screen Resolution - Multiple Display Options

Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
Extend these displays - Treats both connected displays as separate devices
» Show desktop only on 1/2 - Only one of your displays is used.

D - 10 Attaching Other Displays



ATI Catalyst® Control Center

Adjust the video settings from the ATI Catalyst® Control Center.

1.
2.
3.

ok

Windows 7 Information

Open the Display Settings (see page 1 - 17) control panel.

Click Advanced Settings (button).

Click Catalyst(R) Control Center (tab) and then click ATI Catalyst Control

Center (button) to start the control center.

Select either Basic or Advanced and then click Next.

If you have selected Basic a wizard will help you set up the display options, or if
you have selected Advanced you will be taken to the ATI Catalyst Control Center
(you can change the options from the Basic menu or the View menu in the ATI

Catalyst Control Center).

[ cataye convos coec B N ==

ATI Catalyst
Control Center™

Welcome to the ATI Catalyst® Control Center

What would you like to use?

\

{" Basic [Easy Setup Wizards and Quick Settings]

Provides beth step-by-step assistance and Qi
display setup, and other common tasks,

fings for changing your

I~ Dont showthis page again

You can choose betwsen "Basic” [Easy and Quick] or "Advanced” at any
time.

Click Next to continue

Note that the control panels
pictured in the following pages

— are from the Advanced set-
tings.

Bt Next >

4

ATI Taskbar Icon

The ATI Catalyst Control
Center can be accessed as
above or by double-clicking
the icon Eidl in the taskbar
(or by right-clicking the icon
and selecting Catalyst
Control Center).

If you don’t see the ATl icon
in the taskbar, click Prefer-
ences (tab) in the ATI Cat-
alyst® Control Center,
and select Enable System
Tray Menu.

Right-click the ATI icon i
to bring up the taskbar
menu.

FigureD -5
ATI Catalyst Control
Center Basic Settings

ATI Catalyst® Control Center D - 11
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The ATI Catalyst® Control Center provides additional video configuration con-
Y trols and tools which allow quick access to features such as display options, 3D Set-

tings, color and Help menus etc. Adjust settings from the options in the Graphics
Settings Tree View pane.

Help Menus

Click Help (tab) and se-
lect an option from the
drop down menu. Press
F1 to bring up Help for
any currently selected
page.

Figure D - 6
ATI Catalyst Control
Center Advanced
Settings

D - 12 ATI Catalyst® Control Center
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Using the Fn + F7 Key Combination to Switch Displays
You can also use the Fn + F7 key combination to quickly change display configura-
tion and modes.

1. Attach your external display to the external monitor port/HDMI-Out port and turn it

on.
2. Pressthe Fn + F7 key combination.
3. Anon-screen menu will pop up.
4. Use the cursor keys (or Fn + F7) to select the appropriate configuration from the
menu, and press Enter to confirm the selection.

Figure D - 7

Disconnect Projector Duplicate Extend Projector only Fn + F7 Display

M W EE gu o

.|
ATI Catalyst® Control Center D - 13
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The Power Sources

Z The computer can be powered by either an AC/DC adapter or a battery pack.

Silent Mode

Use the & key to tog- || AC/DC Adapter

gle Silent Mode to re- | Use only the AC/DC adapter that comes with your computer. The wrong type of AC/

duce fan noise and save £ 1y adapter will damage the computer and its components.
power consumption.

Note this may reduce | 7  Attach the AC/DC adapter to the DC-in jack on the left of the computer.
computer performance. | 5 pjyqg the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page D - 27).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page D - 23.

. |
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Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

4

Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the Lock Button Menu in Windows 7. This will help prevent hard disk or system
problems.

Switch user

Default Program| Log off

Lock

Help and Suppol

Restart

Sleep

Hibernate

Turning On the Computer D - 15

4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as
Stand by or
Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page D
- 20 for details).
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Power Plans

4

Resuming
Operation

See TableD - 3, on
page D - 21 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

FigureD - 8
Power Plan
Advanced Settings

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

" = Al Contici Panel eens + Fowsr Options » £dit Plan Seftings

Change settings for the plan: Balanced

Chocss the sleap and display settings that you wan your comguter 10 s

=

l On battery A Poggedin
2 mirstes *| |5 e
5 e * 10 e
(15 mimdes * 30 mirtes

Advanced selbngs

Select the power plan that you want to customize, and

; then choose settings that reflect how you want your
computer lo manage power.

W

urrently unavailable
Balanced [Active] -

Balanced
Require a password on wakeup
Flugged in: Yes =
& Hard disk
i f Desktop background settings

Wireless Adapter Settings
i ¥ Sleep
& USE settings

# Power buttons and lid

Restore plan defaults

[ox || conn
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing

any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-

ered.

Click to Show/Hide
additional

power plans\

@ kel # » Control Panel » All Controd Panel ltems » Power Optiaons

Select a power plan

Plans shown on the battery meter

@ Balanced (recommended)

Automatically balances performance with energy consumption on capable hardware

armance where passible

Screen brightness: @

Windows 7 Information

4

ATI PowerPlay™

PowerPlay™ in the ATI
Catalyst Control Cen-
ter (in the Graphics Set-
tings Tree View pane)
allows you to set your
graphics processor set-
tings for higher perfor-
mance or longer battery
life.

Figure D -9
Power Plans

Power Plans D - 17
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Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the
default power-saving state in Windows 7.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows 7 combines
the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are
not using your computer for a certain length of time, which you specify in the operating system, it will enter
Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desk-
top) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power.
After an extended period the system will save all the information to the hard disk and shut the computer down
before the battery becomes depleted.

.|
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Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan to
be away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Switch user
Default Program Log off
Lock
Help and Suppo
Restart

e @z N | Sleep

»
(Shut down Hibehnate

Power-Saving States D - 19

Figure D - 10
Lock Button Menu
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Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-
saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.

/ ‘,; « Power Options » System Settings ~ | +¢ W Search Control Panel o)

Password Protection

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

It is recommended that you
enable a password on wake p e
. Paower and sleep buttons and lid settings
up in order to protect your j
On battery

data. ,-’ Plugged in

@ When I press the power button: [Sleep '1 lSIeep vl
Do nothing

However you can disable

this setting from the Power @ wnentores e s o

Hibernate
Shut down

Options menu by clicking f‘ When I close the lid: |Sleep <1 [Sleep -

Require a password on
wakeu p in the left menu, Password protection on wakeup
and Selecting the OptiOI’lS & Change settings that are currently unavailable

. . (@ Require a password (recommended)
(CIICK Ch an ge setti n_gs th at When your computer wakes from sleep, no one can access your data without entering the correct
are cu rrently unavailabl e)_ password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't
locked.

Figure D - 11
Power Options Define
POWGI’ BUttOI’]S Save changes Cancel

.|
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the

sleep button (Fn + F4 key combo).

Windows 7 Information

Power Status

Icon 1Dv/(l) Color

To Resume

Orange (AC/DC adapter)

Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power B

utton

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons D - 21

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

TableD -3
Resuming
Operation
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Energy Star Power Saving
This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into
a low-power sleep modes after a designated period of inactivity. If you want to enable Energy Star power saving
then follow these instructions: —
@ (e

Customiz|

1. Right-click the taskbar icon.
2. Select Power Conservation Modes.
3. Select Energy Star to use the Energy Star power management and override other power saving settings.

Power Conservation Modes |

Figure D - 12

[Svstem State ' Energy Star Menu

Power Conservation Modes

Power Conservation Modes

" Normal

{" Battery Save

* Energy Star
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
D - 8 on page D - 16).

Click the battery icon (& in the taskbar to see the current battery level and charge
status.

=)

E 81% remaining || Advancadssmacn
Select the power plan that you want 1o customize,

v
; &nd then ehocse settings that reflect how you wast
' your computer to

Select a power plan:

@ Balanced

(7)) Power saver

# Desklop background settings
i Wireless Adapter Settings

+ Sleep

# LSS settings

& Pt buittrne aned il

Adjust screen brightness
Maore power options

Bewore plan defaults

[ ][ Comem

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure D - 13
Battery Icon
(Taskbar) & Battery
Advanced Settings

Battery Information D - 23
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4

Windows Mobility
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power

Conserving Battery Power

Use a power plan that conserves power (e.g Power saver), however note that
this may have an affect on computer performance.

Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

Reduce the amount of time before the display is turned off.

Close wireless, Bluetooth, modem or communication applications when they are

plans used and wireless

not being used.
device status etc.

» Disconnect/remove any unnecessary external devices e.g. USB devices,

ExpressCards etc.

98 Windows Mobility Center [ [ e |
Figure D _ 14 & 2‘,5;1?"):655 ¢ _"‘fW | Mute jl 71% remaining g Wireless off
WlndOWS MObIlIty U U Balanced irn wireless on
Center

Brightness

No display
S connected

®

Volume

No sync
partnerships

Battery Status

@g@ Not presenting

Connect display

J| |

Sync settings

J|

Turn on

External Display

Sync Center

Presentation Settings

Wireless Network

€
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
(e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 27 for instruc-
tions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page D - 23
for more information on how to maintain and properly recharge the battery pack.)

.|
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Proper handling of the Battery Pack

7[:1: » DO NOT disassemble the battery pack under any circumstances
Caution » DO NOT expose the battery to fire or high temperatures, it may explode

* DO NOT connect the metal terminals (+, -) to each other
Danger of explosion if
battery is incorrectly re-
placed.

AN
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even

if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut

down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after creating it) and click Change plan settings > Change advanced power

settings.

Sl # = P Cpsons b Lkt Fuan Settege

el F = A Cremi Pavel Baerra ¢ Poome Opsiomn.

Sl 7 = Power Optom b it Pas Sertrgs

Windows 7 Information

Figure D - 15 - Create Power Plan - Discharge Battery
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

(53 rover ooy R T T | | [ rover cpion WS ) e
Advanced setiings Advanced setiings /
\ Select the power plan that you want to customize, \ 5~ Selectthe power plan that you want to customize, B attery Ch arg | n g &
and then choose settings that reflect how you want P and then choose settings that reflect how you want g
= your computer to manage power. = your computer to manage power. Mal nten ance
% Change settings that are currently unavailable % Change settings that are currently unavailable
?
[Discharge Battery [Active] - [Discharge Battery [Active] - How do | fully charge the battery
When charging the battery, don’t sto
# Multimedia settings = Plugged in: 5% = N g g . . ry’. . p
= Battery = Low battery natification until the LED charging indicator light
(= Critical battery action On barter_y: Off ChangeS from Orange to green_
On battery: Shut down Plugged in: Off

[= Low battery action

On baﬂery:' Do nothing ™

Plugged in: Do nathing
= Low battery level

(|

On battery (%): _ = Plugged in: Do nothing \j HOW do | maintain the battery?
Plugged in: 0% & Reserve battery level (3 Completely discharge and charge the
= Criti On battery: 0%
. (mf:'hgifi?jli:e' . 7 S i ‘ - battery at least once every 30 days or
| il ' : <l U : after about 20 partial discharges.
Restore plan defaults Restore plan defaults
[ ok |[ cancer ][ apoy | [ ok [ camcel |[ appy |

Figure D - 16 - Power Options Advanced Settings - Battery

* Low battery levels = 0%

« Critical battery Levels = 0%

* Low battery action = Do Nothing

« Critical battery action (On battery) = Shut Down
* Critical battery action (Plugged in) = Do Nothing
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu. Follow the instructions to install the
driver. Alternatively click Start, navigate (Browse..) to
the executable file and then follow the manual setup in-
structions.

[ 3 Drivers Installer == ==
oS .
Dl

Figure 5 - Drivers Installer Screen 1

Windows 7 Information

1. Check the driver installation order from Table D - 4 (the
drivers must be installed in this order) which is the
same as that listed in the Drivers Installer menu
below.

2. Click to select the driver you wish to install, after
installing each driver it will become greyed out (if you
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver
installation procedure as listed on the following pages.

Figure 6 - Drivers Installer Screen 2
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Windows 7 Drivers Page #
Chipset Page D - 31
Video Page D - 31
Audio Page D - 32
Modem Page D - 32
LAN Page D - 32
TouchPad Page D - 32
CardReader Page D - 32
Hot Key Page D - 32
MEI Driver Page D - 33
Wireless LAN Module (Win 7) Page D - 35

3.75G/HSPA Module

Page 7 - 29/Page 7 - 38

Fingerprint Reader Module

Page 7 - 43

PC Camera Module

Page 7 - 49

Table D - 4 - Driver Installation

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Programs and Features item (Programs >
Uninstall a program). If you see the individual driver
listed (if not see below), uninstall it, following the on
screen prompts (it may be necessary to restart the com-
puter). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the driver in
question.

If the driver is not listed in the Programs and Features

item:

1. Click Start and click Control Panel.

2. Double-click System (icon); System (icon) is in
System and Security (category).

3. Click Device Manager (in the left menu).

4. Double-click the device you wish to update/reinstall the
driver for (you may need to click “+").

5. Look for the Update Driver button (check the Driver
tab) and follow the on screen prompts.
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Driver Installation Procedure

2 Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).
Driver Installation General Guidelines )
The dri installati d tlined in thi Chlpset
e driver installation procedure outlined in this . . .
Chapter are accurate at the time of going to press. 1. Click 1L.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
Drivers are always subject to upgrade and revision 3. Click Finish to restart the computer
so the exact procedure for certain drivers may differ ' )
slightly. As a general guide follow the default on Video
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many 1. Click 2.Install Video Driver > Yes.
cases a restart is required to install the driver. 2. Click Next > Install (button).

3. Click the Express (or Custom if you prefer to
manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.

5. Click Finish.

. |
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Audio

1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.

3. The modem is ready for dial-up configuration.

LAN

1. Click 5.Install LAN Driver > Yes.

2. Click Install.

3. Click Finish,

4. The network settings can now be configured.

TouchPad

1.

Click 6.Install Touchpad Driver > Yes.

2. Click Next.

3. Click the button to accept the license, and then
click Next.

4. Click Finish > Restart Now to restart the com-
puter.

CardReader

1. Click 7.Install CardReader Driver > Yes.

2. Click Install.

3. Click Finish.

Hot Key

1. Click 8.Install Hotkey Driver > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.

It is recommended you now install the MEI Drive (see
over).
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MEI Driver Windows Experience Index

1. Insert the Device Drivers & Utilities + User’s After the drivers are installed follow this procedure to
Manual disc into the CD/DVD drive. ensure an accurate rating from the Windows Experi-

2. Click Option Drivers (button). ence Index:

2 g::gt ZN'éthf I{(L\g EIN[;;I,[V?N;?S' 1. Click Start, and click Control Panel.

5. Click Finish. 2. Click Performance Information and Tools

(System and Security > System > Check the
Windows Experience Index).

3. Click “Rate this computer”.

4. The computer will take a few minutes to assess
the system performance.

5. Close the control panel.

. |
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Optional Drivers

See the pages indicated for the driver installation procedures for any modules included in your purchase option.
Where Windows 7 information differs from Windows Vista it will be included in this chapter; if Windows 7 in-
formation is the same as Windows Vista then refer to Chapter 7 as indicated on the following page.

= \NA {
' i\f’_iobi_le (Jm_:n'e, '

Please follow steps from top to bottom in order to install Option drivers.

Figure D - 1 - Drivers Installer - Option Drivers Menu
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Bluetooth Module (Win 7)
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a
driver. See “Bluetooth Module (Win 7)”” on page D - 36 for configuration instructions.

Wireless LAN Module (Win 7)

See the specific Windows 7 driver installation and configuration information in “Wireless LAN Module (Win
7)” on page D - 41.

3.75G/HSPA Module
See “3.75G/HSPA Module” on page 7 - 25 for driver installation and configuration information.

Fingerprint Reader Module (Win 7)
See the introduction in “Fingerprint Reader Module (Win 7)” on page D - 47, and check the installation pro-
cedure.

PC Camera Module
See “PC Camera Module” on page 7 - 48 for driver installation and configuration information.

. |
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Bluetooth Module (Win 7)

\ A/
. ’Ll‘ . The operating system’s Bluetooth Devices control panel is used to configure the
Wireless Device Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the
OperaAt.'on Aftboard Fn + F12 key combination (see “Function/Hot Key Indicators” on page D - 5) to
HEES toggle power to the Bluetooth module. When the Bluetooth module is powered on,

ISR UREEEE  the (@) LED will be orange and the on-screen indicator will briefly be displayed.
electronic transmission de-
vices aboard aircraft is usu-

ally prohibited. Make sure
the module(s) are OFF if

4

et PRI Bluetooth Data Transfer

aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.

.|
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Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it 4
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Add a Device
2. Make the device discoverable (to do this check your device documentation).
Click Start, and click

To Turn the Bluetooth Module On Control Panel and then
1. Press the Fn + F12 key combination to power on the Bluetooth module. click ~ Devices and
2. A Bluetooth icon EJ will appear in the taskbar. Printers ~ (Hardware
3. You can then do any of the following to access the Bluetooth Devices control ane Spund). Cligk &2l

panel. a device to search for

any available Bluetooth
+  Double-click the taskbar icon [ to access the Bluetooth Devices control panel. devices.
« Click/Right-click the taskbar icon g3 and choose an option from the menu.

e L Add a Device
()0 % o Devicesand Printess » Bluetosth Devices « | by [ Seorch Devices and Printen ) f . -
e — < Allow a Device to Connect
Addadeoce  Add a prntes - @ .
Show Bluetooth Devices Flgure D - 2
Send a File Bluetooth Devices &
Receive a File Click Icon Menu
Jaoin a Personal Area Metwork
0 Rems
e,
ﬁ.!.f Open Settings
i .
Add a device Remove Icon

7/14/2009

Right-Click Taskbar Icon a
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To Add a Bluetooth Device

/ 1 1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.
Pairing Options - .
o ==
If a device has been pre- () IF Adda deice
viously connected then
the pairing option menu Select a device to add to this computer
WI" appear When y0U at- Windows will continue to look for new devices and display them here.
tempt subsequent con-
nections. You can choose [ 995 - Phone Memory Yy
to have the computer cre- & - i
ate a pairing code for you, l
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.
What if Windows doesn't find my device?
Figure D - 3 Ner

Add a Device

3. On first connection the computer will provide you with a pairing code to be entered
onto the device.
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Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

* hdd s dev /
L hdd pdeace

Type the following code into your device Figure D = 4
et i Pairing Codes Pairing Code
3?855920 ; The example outlined here shows a connection to Example
N i i Sl ' a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
b ot gt code is correct on both devices. Follow the on-
AL —— screen instructions to complete the pairing.
5. Windows will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to
be installed.
7. Click Close.
s T oo e ———
R \j:.:..,; e et S m___-_o
' ~ FigureD -5
1 | -l Pairing Complete &
| it e Bluetooth Device
o Enabled
(= ‘T‘_j
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To

P N1

Bluetooth Help

To get help on Bluetooth
configuration and set- To
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re- 3.
turned search results to

get more information.

Figure D - 6
Bluetooth Settings -
Options

Change Settings for the Bluetooth Device
Click the taskbar icon and select Show Bluetooth Devices.
Right-click on the device you want to change and click Properties to:

Change the name of the device (click Bluetooth, type a new name and click OK).
Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Make your Computer Discoverable to Bluetooth Devices

Click the taskbar icon and select Open Settings.

Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a tick inside it.

Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Connections) has a tick inside it, if you want to be notified when a
Bluetooth device wants to connect.

0 Bheetooth Settings =)

Cutiors | CoM ports | Hardware

] laliow Exietacth devices tn find this coemputer

f, To protect your privacy. select this check hax oaly when
* you went & Bluetooth device to find this computer,

o Allow Bluetoeth devices to gennect to this compates

#| &lert me when a new Bluetooth device wants to connect.

7] Show the Bluetuoth icon in the polifsation ares
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Wireless LAN Module (Win 7)

S
If you have included an Intel® Wi-Fi Link 5300 Series (802.11 a/g/n), 3rd Party . 'ﬁl\ .
802.11b/g or 3rd Party 802.11b/g/n WLAN module in your purchase option, make Wireless Device
sure that the Wireless LAN module is on before installing the driver. Opere:i':’; ﬁftboard

Use the Fn + F11 key combination (see “Function/Hot Key Indicators™ on page 1 - BEASETE RN
13) to toggle power to the Wireless LAN module. When the WLAN module is pow- BEEEEEE s s nes
ered on, the () LED will be green and the indicator &#) will briefly be displayed. FRASEEEEICEESiEt

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. [ EEEEE

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).
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Intel® Wi-Fi Link 5300 Series (802.11 a/g/n) Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1.

2
3.
4.
5

Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc
into the CD/DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

An on-screen message will appear to show the progress of the WLAN installation.

When the message disappears the driver will be installed.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

3rd Party 802.11b/g/n or 802.11b/g/n Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1.

ook wn

Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc
into the CD/DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

.|
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on. /

1. Click the taskbar wireless icon i, and then double-click an access point to con- Network and
nect to or click to Open Network and Sharing Center if you do not see a network Sharing Center
you want to connect to in the taskbar menu (a list of options will appear allowing

setting changes, and creating a new network).

You can also use the Net-
work and Sharing Cen-

ter control panel in

Not connected > :
Windows (Network and
Iﬂ!l(onnections are available |nternet) to connect to
any available wireless
ireless Netw r i e
Wireless Network Connection networks.
ZyXEL ol
PDA_DLINK M et
Cad ) o wschis o o
ADSL-LINKSYSY-N % p TR Tt A Y S 1
oAl oo ek o b oAb s Al Ao COmOVmS, - g TR RN Flgure D-7
DI-524K o1l e o gl s ottt s st Click Taskbar Icon
DWL-g Ul Menu & Network
3 and Sharing Center
corega oAl
Open Network and Sharing Center

408AM ||

- me R | )
Pe W ¢ 8/11/2009
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2. You may need to enter a security key for any access point to which you are trying to
connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access
further options for the connection.
Figure D - 8 .
Network Location e
Set (). i'k, Set Network Location

The network location is now Work

I}, Network name: Work.com
N

Location type: Work

On Work networks, you can see other computers
and devices on the network, and your computer is
discoverable.

View or change settings in Network and Sharing Center

View computers and devices on the network

Close

.|
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5. Click the taskbar icon 4| to see any currently connected networks. N
6. To disconnect from the wireless network you can click the taskbar wireless icon ., /fl\
click the active connection and then click Disconnect (button). Security Enabled
Currently connected to:
Work.com You should try to make
No Internet access sure that any network you
) ) are connecting to is a se-
Wireless Network Connection -
cure network.
default Connected ] =
Connecting to unsecure
° networks may allow unau-
Zy¥EL k) thorized access to your
PDA_DLINK M computer, documents,
o 3 websites and files etc.
CAO0 !!m
corega gﬂ]
= ol - Figure D -9
Open Network and Sharing Center CI ICk Tas kbar Icon

Menu - Disconnect

5:08 AM

o ey R o
o MW A© g
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1.Click Start, and click Control Panel (or point to Settings and click Control Panel).
2.Double-click Windows Mobility Center (Mobile PC).

3.Click the button to Turn wireless off/on, or click the icon m to access the network

menu.
[ Windows Mobility Center (=
s
i _ Z| Display W E % i : :
Flgure D 10 Eﬁ brighthess i 9‘ [T Mute jl 71% remaining .IJ.M Wireless off
Windows Mobility
Center u U Balanced - Turn wireless on
Brightness Volume Battery Status Wireless Network
i No display @ No sync z b 2
' connected partnerships W Notprescoting
Connect display I I Sync settings ‘ l Turn on
External Display Sync Center Presentation Settings
)
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Fingerprint Reader Module (Win 7)

The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-
tector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1.

ook wnN

.|
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Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 4.Install FingerPrint Driver > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

4

Help & Manual

Right-click the taskbar icon
[A to bring up the menu to
select Help.

Insert the Device Drivers &
Utilities + User's Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click 4.In-
stall FingerPrint Driver
>Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User's Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment

1. Click Start > Control Center (Start > All Programs > Protector Suite > Control
Center), or double click the taskbar icon E

2. On the first run of the program you will be asked to click the Accept button to accept
the license.

3. Ifyou have not set a Windows password you will be prompted to do so (note: If you

have not set a password Protector Suite cannot secure access to your computer).

Click Submit when you have entered password.

You will then be prompted to enroll your fingerprints (you can click Tutorial to get

help with fingerprint enroliment at any time).

7 /]
er Homse »  Manage Fingersriets E ¥ Usess RDOL i|

ok

@ Clicks bution over 8 finger o start enraliment.

Figure D - 11 L LA LLLL L
Fingerprint 0 ¢ : |L'1 | l
Enrollment

l iIJ._l ] f ‘ l "', (M A
'. |II [ ol |\ I|”,| |
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6. Click the button above any of the fingers to begin the enrollment process for that
finger. ﬁ
7. Swipe the finger until the progress bar reaches 100% to enroll that finger. . .
. . . Fingerprint
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then
) . Enrollment
click the close [ button to close the window.

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

Control Center Home »  Manage Fingerprints

@ Youare able to use fingerprint logon and other applications using your fingerprint reader. 2

Figure D - 12
Fingerprints
Enrolled
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9. Click the taskbar icon E! and select Start Control Center (and then swipe a finger)
to allow you to Edit Fingerprints, register Applications, edit Settings and access
the Help menu etc. You can also run the Control Center from the Start menu or
Protector Suite > Control Center item in the All Programs menu.

10. Click “Help” in Control Center Home to get more information on any topic.

11. You can also run the Tutorial, or Product Tour video to get more information.

D upek

3=1

v Lock computer

Figure D - 13 E et [ TRt i —
Fingerprint Control R R e K Register..

Center & Biomenu =
R E-Wallet

w, Lock Personal Safe

- A
#4%"strong Password Generator

J,} Control Center...
2
-

Help

12. See “Help & Manual” on page D - 47 for further details.

13. If you swipe your finger over the reader at any time you can access the Biomenu to
lock the computer, register websites, access the Personal Safe, E-Wallet or
Strong Password Generator, open the Control Center and access the Help
menu.
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Fingerprint Control Center Features

Application Launcher

The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings
for web sites etc.

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant to
dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such
as credit card details, account numbers etc.

.|
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4

Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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